
Welcome!  

This document is similar to the resource based online help. There are a few 
additions however.
 
Thank you for using or trying out Compositor. 

Even more thanks if you have registered the program. Shareware developers 
can’t survive on good intentions. :)

Color coding used in this help text is for emphasis and clarity. It is not hyper-
linked at this time. A nice online HTML help system is in development. 

Thrust of this document:
This help text is geared toward the novice image maker. If you have used other 
imaging programs, most of the conventions are similar or same. If you are 
more advanced, please glean from it what you can, there are some tricks you 
will want to know.  For the real newbie, it still may be a "hard" read. I certainly 
hope not. Difficult to know how much to say, and how much to assume and 
Compositor packs a lot of power under the hood for everyone.

That being said, the best way to learn Compositor is to experiment! If you fear 
making a mistake, work on copies of your source images and have fun trying 
out new things. This way, you are only a Revert from starting over again, and 
your source image will be good as new.  
 
Sincerely,

Robert Covington
Artly There

Web:   http://www.artlythere.com
Email: artlythere@kagi.com

You can visit the web site using the Launch items under the Help Menu when 
the program is open. Since v2.6, you can check for a new version by using the 
‘Check for Newer Version’ item under the help menu, if you have an Internet 
Connection open. You can then download any new version at your option.

Registration



The program as of v2.8.2 will display a timed splash. Splash display time will 
increase as the month of demo time progresses to a maximum of 30 seconds. 
After day 30, the application will no longer time out and refuse to run as 
before, but will limit itself to 2 open documents at any time, and only 4 actions 
runs per app session until registered. 

As of v2.8.X and as an experiment in providing incentives for a speedier access 
to funds, the single seat license for Compositor is $35 via Kagi, or $33 for 
PayPal registrations (any difference reflecting time for access to funds and 
cost of processing).  Site and World license options are available at the Kagi 
online store. You not need an account for either PayPal or Kagi.

The price on the Artly There Kagi order page or other registration service in 
operation will always be the final arbiter of the actual price. European Union 
customers using Kagi may have to pay additional VAT fees according to their 
local laws.

To register Compositor:

#1: The best option is to go to http://order.kagi.com/?22z and register the 
program there online. It is secure and convenient, and fast. You can use the 
launcher programs to send your web browser directly to the order page. These 
are in the "Go To URL" folder. You will be mailed a code generally within 12-24 
hours of notice of payment.

Kagi has the feature of being constant while the Artly There business email 
address may change.

#2
You can also pay the single seat fee of $33 via Paypal. Use the URL <http://
www.artlythere.com/cptrpaypal.shtml>   Make sure to note “Compositor” in the 
comments or subject and please notify us if you do not hear back within 2 
business days.  (Spam filters can be problematic) The PayPal send to address should be <
ebay@artlythere.com>, which is our usual PayPal venue.

Snail mail contact (not registration related) can be had at:

Artly There 



PO Box 2336
Cornelius, NC 28031

Foreign registrations (outside North America) should use Kagi, particular if 
need to pay VAT.
 
You can also go online to the Compositor main page at http://
www.artlythere.com/compositor.shtml and follow the link to register that way if 
you prefer.  And for my sake, I hope it is your preference since it encourages 
one to improve a program.

Thanks for reading this, regardless. People who read documentation are Great! 
:)

Compositor Help  v2.9.x

Note: There are changes in the OS X version and documentation that apply only 
to the OS X version. Notably, OS X maintains a permanently engaged virtual 
memory scheme. Compositor for OS X on a fast machine seems to handle 30 
MB images just fine. In general, the design seems optimized for images of size 
6-10MB or less though, and filtering times will go up on the larger images. Such 
is true even for the industry “standards”. If I can get some CoreImage filters in 
there sooon, then things might blit on about, depending on the graphics card 
present.
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Introduction

Compositor was originally written to allow the author to visualize how a portion 
of an image would look when painted on a canvas of a certain size,  and to 
easily crop an image to a common artistic proportion. Compositor allows for a 
quick and easy way to crop an image to a pre-set proportion when in Mat or 
Window mode. Compositor sports a complete painting and editing tool set. 
When in Tool mode you can easily create your own images, or alter an existing 
image. When in Frame and Mat modes, you can edit or view just portions, for 
more flexibility. 

Compositor allows you to alter your images to make beautiful painted looking 
masterpieces, or wildly colored visions never before seen. If you have ever 
seen and enjoyed the end of the movie 2001: A Space Odyssey, you will like 
this application quite a bit, since making those kind of channel and other 
changes is easy.  Beyond that, is it much like older versions of Photoshop™ , 
and a great value.

Compositor can have up to 24 open images at any one time. However, 
performance will increase the less you have open.

A nice feature of Compositor is its ability to fade your last image operation to a 
mixture of the source image and filter result. A "fade undo" so to speak, similar 
to Photoshop™'s Fade <operation> command. You also can paste the 
differences of an image on the clipboard to the image below. Compositor 
subtracts or adds them together and shows the result. This can get wild very 
fast, when you invert, do other actions, and Paste Differences again.

Compositor allows you to record and playback the operations you perform on 
an image in Mat and Window View Modes, as well as Tool mode. The exception 



in Tool mode is that only basic editing operations are replayed, not brush 
strokes for instance, though the gradient tools are recordable now.  It also has 
a Replace Color feature that works great. You can utilize a subset of this 
feature by pasting an image on the clipboard into the fore or back color also for 
a special effect (Paste Into Menu).

In Tool Mode, you can select whatever portions of the image you wish. 
Compositor's Mat and Window View paradigm is that your image is always 
selected. This is referred to by several names: selection frame, view rect, 
image view, etc. Just drag it to size, or hide it when you want. It is always 
there.  When in Compositor’s frame modes, this comes in real handy. This 
frame can be kept in the image's natural ratio, or resized to what you wish or 
set to any of several preset proportions, or to a custom one, quickly.

In   Tool Mode, you can do near anything you would want to do as with most 
any other painting or editing application, plus many things unique only to 
Compositor. It’s a great complement to your other creativity enhancers.

Compositor Help version 2.8

Tool Mode:

Tool Mode is 1 of 3 Modes in Compositor. 

Tool Palette

Compositor has a spiffy tool set since v2.0

In the below list, the asterisk * Indicates the tool has an Options Dialog available 
by double click of its icon! (Important!)
(For global anti-aliased masking, set the bucket or wand tool checkbox when 
using their options dialogs.)

Opacity for most are set by the Brush Palette's  Opacity/Strength control. You 



can engage that quickly using the keys 1 through 0 (1-10, 10 being 100 
percent). Double click appropriate tools to set important options and 
preferences. If a tool has a triangle icon in the corner, you can press and hold 
to choose more tools.

Here is a list of the tools available in this version.

Selection Rect
Selection Oval
Selection Lasso
Selection Wand *
Airbrush *
PaintBrush/Motion Brush*/Media Brush*
Eraser *
Pencil
Clone *
Fix-It Brush*
Line *
Stampbrush
Gradients (Linear and Radial)
Smudge/Blur/Sharpen
Text *
Dodge/Burn
Crop/Rotate
Bucket Fill *
Dropper
Hand (Move) (Space bar and drag anytime)
Magnify Tool (Zoom/Shrink  also in lower window corner)

*  Options dialog, double click tool to open.

Wand tool sets anti-alias on or off for all selections.

Basic Use of the Tools

Selection Tools

Selection Rect
Selection Oval



Selection Lasso
Selection Wand

These tools are linked with several modifier keys for more control and 
versatility.

Option Key with no existing selection: With the Rectangle and Oval selection 
tools, this will constrain the outline to the point first selected. That is, the 
outline will be drawn from the center outwards.

Option Key plus click/drag inside a selection: If the selection is floating already, 
this will leave a copy. If the selection is not floating, then it will "float" the 
selection contents. Floating means that the image floats above the document 
separately. When you paste an image in Tool mode you will always end up with 
a floating selection. Text selections are also floating. Normal selection outlines 
are not floating, but do act as masks to any filters applied.

Shift Key with no existing selection: With the Rectangle and Oval selection 
tools, this will constrain the selection to a Square or Circle.

Shift Key plus click/drag outside an existing selection: This will create a new 
selection joined with the existing.

Command Key plus click/drag outside an existing selection: This will subtract 
the new selection from the existing. (Prior to v2.5 this used the Control Key, 
contextual issues forced a change.)

Select outside any current selection to Deselect (Select None). This is 
functionally equivalent to keyboard menu shortcut, Command-D. The exception 
to this is the Wand Tool....Clicking outside a selection will just create a new 
selection. In this case, click -inside- the selection outlines to Deselect.

To Move A Selection: Using any Selection Tool above, click and hold inside the 
selection and drag to a new location.  

Airbrush 

The airbrush has several options you can check or uncheck with a double click 
of the tool icon.  It differs from the paintbrush in that the flow of the paint is 
continuous, instead of a dot at a time, according to spacing and brush motion.



You have choices of:

Fade In
Fade Out
Fade In/Out

All of the above depend on the current brush spacing and steps you have set in 
the dialog as to how fast or slow the fade is. Many steps will yield a Slow Fade 
in or out...few steps will be much faster.

This tool is  enabled for all blend modes on the Brush Control palette. However 
if the fade out is set to Background, then it will act much like the Paintbrush. 
Fade to transparent works great with all fade methods (in-out-in/out).

PaintBrush

Paints the current forecolor onto the document.

This tool is  enabled for all blend modes on the Brush Control palette.
The current brush size, spacing, and hardness is adjusted using the sliders on 
the Brush Control palette. You can also adjust the opacity. Depending on the 
tool, this will adjust other options. For instance, when using the Smear/Smudge 
tool, it controls the strength.

Blend Modes

Normal
Add
Difference
Subtract
Darken
Lighten
Dissolve
Multiply
Slide Light
Replace
Colorize
Hue
Saturation



Luminosity
Moribund

These control how the paint color (usually the forecolor) will be composited 
onto your document.

Normal : Leave this selected generally, and for tools other than the Paintbrush 
or Radial Gradient.

Add  : Adds the paint color to the document color. Clips to white.

Difference  : Gives the difference of the paint color and the document color.

Subtract  : Subtracts the paint color from the document color. Clips to black.

Darken  : Gives the darker of the paint color and the document color.

Lighten  : Gives the lighter of the paint color and the document color.

Dissolve : Acts like a local Smooth Nuke filter, disrupting for an artsy effect.

Multiply  : Multiplies the paint color and the document color. Results in a darker 
overlay type of coloration.

Slide Light  : Multiplies or differences the paint color and the document color. 
Results in a lighter color.

Replace : Replaces the background color with the forecolor using a "fuzz" 
factor of 128. See Replace Color dialog for a more global variety.

Colorize : Applies the forecolor Hue and Saturation leaving luminosity. Set 
Opacity to about 10-20 for colorizing a Grayscale image nicely.

Hue : Applies the forecolor Hue to the image.

Saturation : Applies the forecolor Saturation to the image.

Luminosity : Applies the forecolor Luminosity to the image.

Moribund  : Applies a mix of Hard and Soft light resulting in a sort of 



posterization effect. (Subject to future change.)

Motion Brush

Paints the current forecolor onto the document if “Add Paint” is set in the 
options. Uses Twirl, or Lines...depending on Type. Noisy skips random pixels. 
Spastic in the case of Twirl varies the angle from 1 to Angle as it goes, 
randomly. In the case of Lines, Spastic varies count from 1 to Count. Wet Lines 
(v2.6.1 addition) option will smear the lines a bit for a wet look. A nice 
distorter.

Negative values for Twirl change direction (CCW), positive values are 
clockwise. For lines, negative values are random lines, at that count, and 
positive values are radial lines using that count per stroke. Radial is best for 
furry effects, Random is great for chalky painterly effects. Suggested are 25 
Percent opacity when Add Paint is engaged. For Twirl, if add paint is engaged, 
higher angles work best.

Brush Spacing set to OFF (full left slider) give the best speed for all, though 
lines may be better on occasion with spacing of 20 percent or so.

Media Brush

The Media Brush allows for watercolor/dry pigment effects and dimensioned 
paint effects. In general it Paints/Melts the current forecolor into the document 
if “Add Paint” is set in the options. If off, it boils and speckles in the current 
color under the mouse point. Dry speckles paint on, Mixed Wet does the same 
with some melting/blending, and Ultra Wet really melts/boils that image. 

Boil auto-applies as long as the mouse is held down. Stipple adds noise and 
lessens the flow depending on brush/amount settings. Shadow applies a drop 
shadow to the stroke.

Try various brush sizes (larger are better) and hardnesses and Opacities (Brush 
Palette). Try varying Amounts, and Shadow/Pastel options.
 
Brush Spacing set to OFF (full left slider) give the best speed, though mixing 
may be minimized with spacing on, and it makes for better control at times.

Experiment with various brush settings and the Tool options, and you’ll get 



some great effects out of this tool.

Eraser

2 Options: Eraser as block...or Eraser as brush.

In the case of Eraser as Brush, you can adjust it using the Brush Control dialog. 
It will erase to the BackColor.

In the case of Eraser as Block, it is a 16 pixel sized square and it scales with 
the Magnify tool...so if you are zoomed in, it erases little. If you zoom out, it 
erases a lot.

If you have just done an action such as painting or filtering, if you hold down 
the Option key while erasing, you will erase to the Undo buffer.  This erase to 
Undo can be Undone only as long as you do not lift the mouse button and then 
draw again... as this will cause a re-init of the current undo buffer via copy of 
current image back to undo-ville. So, if erasing to Undo right now, make sure 
you do it all on one pass. I'll see about optimizing this at some point in the 
future. A simple way doesn’t come to mind at the moment, though the new 
temp file engine used for the OS X version may aid that.

Pencil

Draws a single pixel width line. Opacity for this is set by Brush  Control. Option-
key and dropper click to change the color quickly.

Clone 

The Clone tool allows you to set a source point, and then paint from that 
source point to your current position. The Source point can be either in the 
current image, or another image. Option Click to set the source point (the 
cursor will change to reflect the Source mode as being engaged) Opacity and 
brush size, and hardness are set using the Brush Control. Double click the clone 
tool icon to set the source as being always “clean”, or including that which you 
have just put down also, a mix of source and destination recycled. You can use 
another document for the source. Click in that document (the cursor may not 
always give you correct visual clues in this case) and then you can clone into 



the front document.

As of v2.7.2, you have the option for Clone Aligned, or Non-Aligned. For the 
first stroke, these are identical (once you’ve optioned the source point)...but if 
you are in Non-Aligned mode, on your second stroke, the source point is not 
offset, it is again starting at your original Source point click point, and not 
offset relative to your first brushs stroke, as with Clone Aligned.

Experiment to see the difference. For instance, if you want the same cloud 
area to be cloned to different places of the image, use Clone Non-Aligned.

Fix-It Brush

The Fix-it tool allows you to paint over areas and have them be filled with the 
side colors of that area. This can be used to quickly knock down damaged areas 
of a scan from scratches or dust. Double click the tool icon to set the ranges, 
and bias towards dark to be replaced, or light. This tool can be used to wipe out 
areas that might take longer with the clone tool. It makes a neat artistic effect 
when applied using a paintbrush like manner.

Line Tool

The Line tool draws from your mousedown point to wherever you let up. You 
can set options for width and Anti-aliasing or not using the Line Options dialog. 
You bring up that dialog by a double click on the Line Tool.

Opacity is set by the Brush Control Palette. With a single pixel wide line, 
drawing will be faster is for example, the opacity is set to 100 instead of 99, as 
the thickline routine is used for anything less than 100 percent opaque.

Shift-drag for pure horizontal or vertical drawing.

Stamp Brush

Cool!  The Stamp Brush puts whatever point you Option click on into the Paint 
source and lets you paint with an image. You can adjust the spacing, and 
hardness and diameter of the brush for various effects, including neat 



repetitive tilings and more. Option Click to set a Stamp source point in either 
your current image or another. If you click near the edge of an image, the 
source image point is offset so as to make sure that the fullest size brush (100 
Pixels) will not lack for image source. Experience will show when the Stamp is 
preferred of the Clone tool for any particular operation.

Gradients

Choices of Linear directional, or Radial blends from Foreground to Background 
colors. 

Drag in the image using the tool to set the blend zone. Short line will give a 
large area of the Foreground and Background colors, with a very quick blend 
between the two. A longer line will give a more gradual blending.

Gradients are enabled for all blend modes on the Brush Control palette. Shift-
drag for pure horizontal or vertical drawing.

Smear / Blur / Sharpen

This set of tools will smear your image, blur a small section, or sharpen a 
section.

When Smearing, it may be best to set the Spacing parameter to OFF on the 
Brush Control Palette.
If the brush size is very large or the spacing is set very low, the tool may have 
a lag time.

Text/Type Tool

This tool allows you to place Anti-Aliased text (or regular) onto your image as 
either Bitmap, or a Selection working as a mask.

The Text Size can be set 2 ways....using the Popup size menu, or entering the 
size into the edit field. The edit field value always override the Popup size 
showing. So if you need another size not on the popup,  enter it. 

If you have the text selected, changes to size or other will be previewed in that 



size/font/style. 

Currently, even if the Text is a bitmap, it will still act as a mask if you filter the 
main image, the exceptions being Invert or Fill, which apply explicitly to the text 
itself.

You can apply the Drop Shadow Artly There Filter to Text.

Notes:
Text exists in a separate reality to the rest of Compositor. Some operations 
simply do not apply to it.

Once deselected, you can not manipulate the text further, unless you choose 
Undo right after.

Text is currently limited to one line at a time.

To leave a copy of your current Text, Option-Drag the selection. You can drag 
the text by clicking anywhere inside it's bounding rectangle. You are not limited 
to just the text outline area like some other programs, which can get dicey 
when the things are small. I’ll offer this as a preference though at some point, 
because the bounding rectangle can get too large for some fonts which report 
bad height information, since I had to use a workaround to avoid clipping 
descenders.

Dodge / Burn

Dodge will lighten your image using the current brush parameters. It has an 
additive effect up to a certain level during any one mousedown cycle. On a 
further mousedown it will lighten yet more. Burn darkens the image the same 
way.

Crop / Rotate

The Crop tool can be used 2 ways...if you have a Rectangle selection, you can 
select the Crop tool and then click inside the selection to crop to that size. 
Crop can be undone if you choose Undo Image as your next step.



You can also just drag out your selection using the crop tool...if you see the 
Tomahawk, you can then crop it. Otherwise click outside the selection to 
deselect or cancel the operation.

The Rotate tool is a shared item with Crop...Drag the tool in your image, and it 
will rotate it back using that angle, oppositely using the current Rotation dialog 
parameters in the Image Menu (Rotate Other Angle...)

For example...say you have an image with some columns, but they are not 
quite straight up and down...drag from the top of a column to the bottom, 
tracing the general or exact direction of the column's 'lean'. The image will be 
rotated using that angle, and you should end up with a straight image now, 
which you can crop to make square again.

Bucket Fill

The Bucket fill tool fills the image using the point you set as the "seed" for the 
fill. So, if you click in a blue area, any other blue pixels near that point within 
the tolerance range are filled using the forecolor, adjusted by how close they 
are to the pure color. Tolerance can be set by double clicking the tool. If you 
don't need it, turn off Anti-Alias, since that will make the tool operate faster. 
But if you want a smoother fill, check it. A tolerance of 0 will fill only those 
pixels exactly the same color as the click point, if there are any near it. A 
tolerance if 255 will fill the whole image, which is pretty much redundant. The 
Fill command would be more efficient. :)

Dropper

The Dropper tool lets you set the foreground or background colors to whatever 
color you click on in your image. To set the Background color without changing 
the forecolor, just click while holding down the Option Key.

Some tools such as the Paintbrush, Pencil and others allow for accessing this 
feature during regular use. Just hold down the option key and click to set a new 
forecolor.

Move Tool



The Move tool, or Hand tool lets you quickly scroll an image to whatever point 
you wish. Just click and drag. This tool can be engaged at any time by using the 
Space bar and dragging simultaneously.

Magnify Tool

The Magnify, or Zoom tool, allows you to see your image magnified or shrunken 
down. To enlarge (Zoom in), click on the image...the scaling will be done such 
that you end up near your click point. To shrink down the image (Zoom out), 
Option-click the image. The cursor will change showing that you will be Zooming 
out (- sign).

To restore your image to normal view, Zoom of 1X, just double click the 
Magnify icon, or Control click in the image using the Magnify tool. 

Color Quick-picker

The Color Quick-Picker allows you to quickly select a common range of 
colors...these will be stored on the Colors palette. Just click on the ribbon, and 
select whatever color you wish...it will be previewed in the Fore/Back color 
squares below. To set the Backcolor, just hold down the Option key while doing 
this. Handy Dandy.

Fore/Back Color Setters and Swappers

The top looking square is the Forecolor.  The one beneath it is the Backcolor.

Forecolor: Current painting and fill color.
BackColor : Current Erase to and Background fill color. Used for New 
Documents, and the BG color for rotations.

You can click a square to bring up the normal Macintosh Color Picker. Click the 
Swap Arrows to switch Fore and Back colors.

Memory RAM Thermometer

Not available in OS X ( virtual memory handles things regardless)

Shows free ram available with the current image(s) in use. 



Frame Mode

Frame Mode or Window View Mode is the second mode available. (Note Frame 
Mode and Window View are used interchangeably) Frame Mode does away with 
the mat effect, and allows you to see the whole window and image if it is scaled 
or zoomed out. When in window view, the complete image is saved, not just 
what is in the view frame when doing any Save or Export operation, or Printing 
for that matter.

Frame Mode is the mode you will want to use most often generally when using 
all the filter and other image operations.

Compositor Mat Mode

Here is a brief description of the program in use. 

(Note: “Compositor Mode” and “Mat Mode” are used interchangeably)

Compositor Mode is the original genesis of Compositor. You can also think of it 
as black mat mode. However, you are not restricted to a black mat, as you can 
use the "B" key on your keyboard to cycle through other colors.

Open an image while in Mat Mode, (Mode Menu: Mat Mode) and drag within the 
middle. If Auto Shrink is on (default is on), the bounding rectangle will shrink 
when "bonked" against the window sides, and you will see the mat that allows 
you to see only a portion of your image. You can then drag the resized image 
view around until you see what you like. To save what you see, choose 
"Save..." in the File Menu. Only what is visible will be saved. You can also 
manually resize the frame with the mouse by dragging any edge or corner.

To instantly reset the frame to the full image dimensions, choose Reset Frame 
in the Options Menu. There’s a pref as of v2.7 for if you swap the aspect ratio 
of a frame and how that is resized.

Tip: When in Mat Mode, and saving as PICT, you can save the current contents 
of the frame with surrounding mat also by combining  < Option Key + "Save..." 
>



This is handy when you have a nice color frame around the image and inset it a 
bit. With this option the whole window is then saved. With the shading options 
of version 1.6 and higher, you can do this in other ways. (Stamp Mat)

Tip: You can toggle the background color from black to gray to white to black 
again with the "b" key.

Tip: You can move and resize the Frame with the arrow keys on your keyboard. 
With no other key down, the arrow keys will move the frame a pixel in whatever 
direction your press, or more if you hold it down. Holding down the Option Key 
+ Arrow Key will let you enlarge the frame in that direction, or proportionally if 
Use Ratio is on. Holding down the Control Key + Arrow Key will let you  shrink 
the frame down in that direction. The exception will be that if Use Ratio is 
enabled, only the left and right arrow keys will operate. The frame will shrink in 
proportion.

Palette Operations

Note: The Tool Palette has its own category. See Tool Mode.

Brush Palette Operation

The Brush palette, along with the Tools, Selections, and Color palettes are not 
available except when in Tool Mode.

1. If the brush control palette is not visible, show it by choosing Show Brushes 
from the Window Menu.

2. Click a brush square to select that brush.

If the size is greater than 35, then the brush is represented by a number.

You can save and load brush sets using the buttons below. These should be 
saved to the Brushes folder for best results.

3. To adjust a brush, click the toggle arrow at the bottom left of the brush 
selecting area to expand the palette.



Adjust the sliders to your preference. 

Diameter goes from 1 to 100. It may say 1, but you wouldn't see the brush 
very well, so the program hedges a bit and adds some behind the scenes. If the 
brush is larger than 79 pixels, the preview gets a red edge, indicating that the 
brush you see is being scaled down in the preview area. It will paint using the 
set diameter though.

Hardness controls the blending of the edges....0 is fuzzy....100 is rough.

Spacing controls how many dots are drawn per distance of mouse movement. 
Set it to about 20 for normal uses. If using the Smear tool, Off is best (0). 
Other tools , including the paintbrush when using certain blend modes will 
benefit from Spacing being set to 0, Off. In this case, less time is wasted 
painting over and clipping areas that have already been colored.

Experience will teach what is the best setting for a given operation.

Blend Modes control the way Compositor mixes the paint color (Forecolor) with 
the image colors. The exception is Dissolve when used with the Brush, which is 
like a Smooth Nuke-Disrupter.  Good for adding edginess to your edges. The 
Airbrush and gradients will insert color randomly with this setting.

The Blend Modes as of this writing are only set up for the Paint Brush , 
Airbrush, and Gradients.

Cool: You can toggle the brush selection area colors by clicking the little black 
and white rectangle at middle underneath!

Color Palette Operation

The Color palette is a cool quick picker. Just click in the circle of colors you 
wish, and drag the cursor. The color will be the one you are over when you 
mouse up, or otherwise click.

The last 10 colors for each light/dark combination are saved around the rim. 
You can click these to set the paint color super fast.



The middle larger colors are toggled...you can click one to get the other, and 
vice versa. These represent the last 2 colors used.

You can also use the Pop-up quick-picker on the Tool Palette to set the color 
quickly, as well as clicking the fore/back color squares just below to get the 
normal Mac OS Color Pickers.

When calling up the Replace Color dialog, the default settings for that are the 
current fore and back color.

Selections Palette Operation

Selections can be saved here for later re-use. Double click an icon to load that 
selection. Or press the Load button. Option - press the Load button to get a 
dialog for a particular file not in the Selections Folder. Save will save the 
current selection. 

You can also Save and Load selections via the Select menu.

Quick Palette Operation

The Quick palette helps you speed up common operations. Just click the 
operation you wish. Many of the operations respond to the Option key for 
additional versions or different operations of the filter chosen.

For instance, Median is converted to Median Smooth by use of the Option Key. 
The Boid Lines responds to all keys set up for it, and as described in the Boid 
Lines item under FilterVille.

To toggle between combinations faster, just Command-Click on any item, and it 
will toggle the options, or just use the Toggle button.

Option plus Self Compare will invert the result automatically, sometimes this 
give a more artistic result.

Actions Palette Operation



The Actions palette scans the Actions folder (or creates one if it isn't there) 
and loads any Action files found there into it's file list. The folder is scanned 
each time the window is open. Several demo actions ship with the normal 
release of Compositor versions. You can add your own there also. They need to 
remain in the native Compositor file type and creator code ("TEXT" and "CPtr") 
to be read.

Operation: Set the playback speed by clicking any small green square. Left is 
Faster (all the way left is no delay, square one). Slower is to the right. These 
reflect the choices given under the Mode menu Replay menu.

Pause button, plus Run, will engage step mode, and play one action per press of 
the Run button. Pause button up will let Run cycle through the entire actions 
list, at the speed set in the Replay menu, or the green speed squares. Stop 
resets the whole works.

Important Consideration: Actions use all 3 image buffers and then some on 
occasion. The Undo image file is reloaded at actions'  end. When in step mode, 
the file will only be reloaded after the actions are completely done. Otherwise, 
any regular run loads the undo image after the actions cycle is complete.

Zoom Window

The Zoom window offers a 2X enlargement of the area under the mouse, if the 
image is the current active document. If you do not move the mouse after a 
half second or so, the image is anti-aliased using the same quality filtering as 
the scaling dialog. It's Neat. For 3X using a different algorithm and to switch 
between, hold down the Option key when opening the Zoom window from the 
Window Menu.

Info Window

The Info window shows the current RGB components under the mouse. It also 
shows the angle of any line drawn when using the Rotate To Other Angle dialog, 
and the Mouseline feature, or the Rotate Tool on the tool palette.

The rotation will be the opposite of any line drawn. This is to aid in the 
correction of skew more easily. Line up along some vertical feature that should 



be up and down, the program will rotate it back to vertical. You can then crop 
the image to make things more like a rectangle, or clone some new material 
over the background color the program inserts in the out of bound margins.

Clipboard and Cropping in Tool Mode

If you have a rectangular selection type, having used the Rectangle select tool, 
you can crop to that rectangle using the Crop tool by clicking inside the 
rectangle. Otherwise, you can crop using the crop tool to first drag out a 
rectangle, and then click inside to crop. 

You can also use the Edit menu Crop command if a rectangular selection is 
present.

If you have an image on the clipboard, you can choose New With Clipboard in 
the File Menu.  You can also choose New With Current to place any current 
selection into a new document. If you have an image on the clipboard, and 
choose New Image, the document is pre-sized to the current clipboard 
contents.

Clipboard and Cropping in Frame and Mat Mode

If you have an image on the clipboard, you can choose New With Clipboard in 
the File Menu. If you have a portion of an image framed with the always 
selected frame rectangle (you can hide the frame), you can crop to that image 
portion with the New With Current command, or the Crop command in the Edit 
menu. At any time you can hide the selection rectangle, or view rect, using the 
Hide Frame under the Options Menu. The keyboard shortcut is Command-H.

If you have an image on the clipboard, and an image already open, if you Paste 
using the Edit Menu choice, the clipboard image will be placed into the selection 
rectangle and scaled up or down to fit.  If you have no image on the clipboard 
and try either pasting an image into a picture, or making a new one via the 
clipboard, you will hear the friendly Compositor beep sound, and nothing will 
happen.

Scaling an Image



If you have an image open , you can scale it up or down using the Scaling 
window in Compositor.

There are 3 ways to scale an image as of v2.8...filtered (anti-aliased) or non-
filtered , or if having v6.0 and above,  using Quicktime™ (which is nicely anti-
alised)

It is important to be aware of the different methods and also how the direction 
of going up or down in size figures in here.

Filtering is best used when shrinking an image by just a small percentage of the 
original size. That is, going from 100 percent to 92 percent , for example. If 
you are enlarging, always use filtering if possible. It will make the results look 
much better. Normal is fine. Poly 3, or Sharpen, adds a bit of sharpening. The 
maximum is 1.0. This is not a very extreme effect.

If you are scaling down, from say 100 percent to 50 percent, Filtering becomes 
a waste of time unless you need to preserve the maximum of detail in your 
image. This is because Copybits, a Mac toolbox call is used to automatically 
scale when Filtering is off, and it will smooth the image by averaging, removing 
jaggies.

Going up however, Copybits just does a nearest neighbor method, and thus is to 
be avoided.  

Quicktime gives the fastest results by far, but the slower Sinc or Normal may 
give a slightly sharper result. 

Stretching a Canvas

You can stretch an image size/background using the Stretch Canvas dialog.

Select how you wish extra space to be added (or removed) from the image.

The image will be adjusted using its placement relative to the other squares. 
The Default is centered. This will add a portion of the values entered equally (or 
1 more on the right, depending on divide) around the image. The color of the 
new area will be that of the Background Color shown on the Tool Palette.



Custom adjustment : To add to the top alone for example, enter a value for the 
new height, but leave the width unchanged, then choose the bottom middle 
square.  Voila. :)

Opening Images

To open an image when using Compositor, you have several ways.

Method number one is to use the File: Open command, Command-O, keyboard 
equivalent and choose a file using the dialog.

Method number two is to use the File: Open Recent submenu and choose any 
image title there. If you have not yet opened or saved any images, this menu 
may be blank, depending on whether you have used another version of 
Compositor before. There is a limit of 15 items remembered. They are typically 
moved down in the list as another is added.

Method number three is to have something on the clipboard and use the File: 
New Using Clipboard: submenu and choose an option there. 

If you already have an image open, choosing New Using Current will give you 
either the current image, or the selection contents, or if in Frame or Mat mode, 
the contents of the frame on up to the entire image if the frame is sized to 
such.

Method number four is to create a new image entirely using the New: Image

Method number five is  to use the Import menu to open an application or other 
resource file and import a PICT resource (assuming the file contains some).

Lastly,  drop an image file onto the application icon. If it is recognized, it will 
open on up.  

Import to Clipboard places the image on the clipboard for Paste Using fun  or 



other operations. Handy.

Saving Images

Compositor  v1.9.5 always writes a new image, as it is working from a copy of 
the original image that you load. It will overwrite the original image only if you 
name the file to be saved the same as the original.

Compositor  v2.0 and up allows for saving over an existing image...using the 
Save command. To save a copy and also make that the current image (this is 
always recommended), choose Save As...

To make a copy of the current image without making it the new and current 
document, choose Save a Copy...

In Mat View when you do a save operation , you will save whatever is visible 
within the current view rectangle.

To save the whole view, mat included, along with any view frame and color, 
choose < Option Key + "Save..." >
In Frame Mode , also called Window View in these docs, you will always save the 
entire image. 

When saving as a TIFF, you can specify either Macintosh or IBM PC versions. 
This reverses the byte order in the TIFF header so as to be more compatible 
with either variety of machine processor. Most TIFF readers will import either 
just fine. 

Saving Actions

One of the cooler features of Compositor is that you can save and replay 
nearly every filter action you apply to an image. After an image operation is 
done, you can save your actions as a separate file and then recreate the same 
effect either on the original image again, or on another image.

If you run an actions file via the menu however, this is not (currently) recorded 
into any actions file list yet to be saved.



There are a few filters that are not exactly repeatable due to the random 
nature of their operation. "Add Noise" is one. "Pixel Blast" is another. Copy 
Scaled will not repeat, nor will New With Clipboard, though New With Current 
will.

The Histogram Window will not be showing back up in an actions replay , as it is 
for reference as to how your filtering affects the pixel values from dark to light. 
Image Rotations  other than simple 180 degree rotations are recorded, however 
they will not play back currently. Please see the release notes for more 
information.

Generally "what you saw is what you will get" later. 

I added actions because I have always been bummed out when I made 
something nice, and then didn't remember how I got there. With Compositor, 
you can always have some road map back to your creation. Whenever you save 
an image, you will also be asked if you desire to save your actions. You can 
choose whether you wish to or not then. When reverting an image back to its 
original state after experimenting for example, you will also be asked first 
whether to save the current actions state. Choose cancel if you don't want to 
save them. 

Actions are of the default title "Actions(<filename>) If the filename is longer 
than the field, it will be truncated.
You can of course name the actions file anything you wish, but this naming 
convention allows for the founding image to be noted more easily.

Replaying Actions

Replaying Actions is simple. At the bottom of the Image Menu, you will see 
"Load Actions..."

You can as of v2.8 also use the Actions menu in the FilterVille menu. This 
folder is scanned every menu click, so new files will show up on the next save. 
There is a 2 level deep hierarchical limit to any subfolders in the Actions folder. 
Further, more, any folders will hide the files within from the Actions palette (fix 
for that on the list (as of v2.8)).

Choose the Image Menu/ Load Actions item and you will get a file dialog. 



Locate the file you wish to replay. It will load immediately and being running. 
You can stop the actions in progress at any time by pressing either the space 
bar or the ESC key.

If you load the wrong file, or a long file, this is helpful.

You can also initiate an actions run by using the Quick Palette and Actions 
Palette. See more about that under Palette Operations. As of v2.0, you can run 
actions if an image is open just by dragging the actions file onto the application 
icon, or double clicking the actions file.

Actions not recorded that may affect the resulting image: If there is nothing on 
the clipboard when you run the actions, and something was there the first time, 
and a paste operation is thus carried out in the script, you will of course be 
working from then on with a different image base as the paste will be 
attempted but nothing will be pasted. 

There are a few filters that are not exactly repeatable due to the random 
nature of their operation. "Add Noise" is one. "Pixel Blast" is another. "Smooth 
Nuke" is yet another one. The most random one of all will be "Stars To Black". 
The new film grain noise filters will not duplicate exactly. To find out which 
filters work identical on a re-run, you can copy your image after it is filtered, 
Undo the filter, re run the filter, then paste Differences. If you see all or very 
near black, you are fine. That means the differences were non existent. You 
can run Equollide  on this result also. If you still see nothing...you get the Exact 
same results with that filter, on that image each time it is run, at least at that 
frame, or selection size.

One benefit of this is that you will get different images using the same set of 
actions, and the mutations can be very artistic. The downside is that you may 
have come up with the most wondrous image of all time, and you didn't save it 
as it was, hoping to replay the actions to re-create it later only to see that it is 
now nearly the same, but not quite.

Solution: Save the image master, and the actions too. Now anything new is 
gravy. 

Not too many applications allow you to re-run the course of a creative session. 
You will find this a neat feature of Compositor.  You can re-run the actions on a 
different source image as well, which is the main point of it all I suppose.



You can clear any actions at any time from the current buffer by choosing 
Clear Actions from the Image Menu. Sometimes you just want to start with a 
clean slate.

Actions are purged when :

An image is Reverted
You choose Clear Actions
You close the image.

As of v2.0, Compositor maintains a separate actions buffer for each open 
image.

When re-running actions, New With Clipboard may not be enabled as of v2.0. If 
you need that to work, contact the author at artlythere@kagi.com. There are 
some technical reasons for the current status, but they can possibly be worked 
around later. Image setup actions are not done often as a sequence of filters 
might be.

New With Current will work in replay however. So if you need to scale an image 
fast and make a new one, the workaround is to do a  Copy Window, set the 
frame to the size/proportion desired, then Paste it, and then choose New With 
Current.

This sequence would replay fine.

Hope that helps.
 

Menu Reference

File Menu

The File Menu is where it all begins.

Here are the commands in the File Menu :

New Image >



Open...
Open Recent >
Import
Close

Save
Save As...
Save a Copy...
Revert

Slide Show Prefs...
Slide Show

Sequence >

Page Setup...
Print...

Quit  (this is under the Application menu in OS X)

Here is a quick guide to the above items: 

New Image  is your starting point for creating a new image...You will then get a 
dialog for some initial image settings. Set the height and width, and resolution 
desired, and also the document name if you wish. If there is an image on the 
Clipboard, it's dimensions will be the default window size. The create your new 
document by pressing the New button.

There are also 2 more options...New Using Current, and New Using Clipboard.

New Using current, depending on Mode,  will take the current image, or current 
selection, or current frame contents, and create a new image with it.

New Using Clipboard will create a new image using the contents of the 
Clipboard, if there is an image present.

Open...    If Quicktime is installed, choosing this will open a dialog allowing you 
to preview the image you wish to open, otherwise you will get a standard dialog. 
Choose your image, and your image will open. The time that takes depends in 



part on the size of the image, and the number of images already open.

If the directory you are parsing contains many images, you can bypass the 
sometimes slow parsing of all the image files via Quicktime's preview sleuthing 
by using the Option Key when choosing "Open...". If you don't have Quicktime 
installed, you will always get speedy service at the expense of no preview 
option. This information and process may be made obsolete if Navigation 
Services are used.

Compositor images are typically 72 DPI resolution, but it reads higher resolution 
image information to set the image size when opening. The file's native DPI is 
kept if set in the preferences.

Compositor works all in RAM when it can (in OS X, some virtual memory may 
come into play). Some files are written to disk as temporary files and then 
deleted when done.  If you suffer a crash, it is possible a copy of your image 
will be recovered for you automatically if you re-run the program right away.

Compositor -always- works with 32 bit (True Color) offscreen images, so quality 
is assured. The trade-off, if you want to look at it that way, is that more 
memory is required.  

Open Recent (Items)

This remembers the aliases to the last 15 items opened, or saved , if checked 
in the preferences.  If you have saved or opened any images, there may be 
aliases there. 

Import >   Import To Clipboard, Import PICT Resource.

This allows you to open an image not to a window, but to the Clipboard for 
pasting or other operations.  You can also Import a PICT Resource from an 
application or resource file, if any are in the file. You will get a dialog. Advance 
through the images using the arrow keys. You can then choose the image you 
want.

Import to Clipboard is useful when you want to re-paste an original of your 
image onto the current image, or paste another over the current one to do a 
Fade Last with.



Close

Closes the current image window. If you have done any actions on the image 
that may have changed it, you will be asked to verify the close as to whether 
you wish to save the image. Otherwise, it will just close the image.

Save

If you have opened an image, and made some changes, you can save them 
using this command. It will overwrite your original image. Use it carefully, you 
will probably want to use Save As... instead to save a copy of the current 
image. 

Save As...

Save As allows you to save a copy of your current image, unless you choose to 
replace the original, by overwriting it (same location, same filename).  After 
your image is saved, the window title is changed to reflect the filename it was 
saved under.

Save a Copy...

Save a Copy allows you to save a copy of your current image without updating 
the window title or internal record that Compositor keeps for the current image.  
It is a duplicate of the current document, just with a different file name (one 
hopes.)

In Tool Mode you will save the entire image.

If you are in Mat Mode, you will save only what is visible inside the mat frame if 
it has been resized.
If you hold the Option Key down while in this mode, you will save the complete 
window, including the current frame and color. A nice feature of Compositor is 
that you can Save As, then choose Undo, and then save a new version after 
applying a different filter.

If you are in  Frame Mode, you will save what is visible in the window as with 
Tool Mode.



Revert...

Revert discards any changes to the current image, and reopens it in the current 
saved state as previous.

Slide Show...
Slide Show Prefs...

Use these 2 items setting up the slide show feature.  See the Slide Show docs 
for more information.

Contact Sheet...

Create index sheets for your image folders. Render to file or HTML image 
gallery. See Contact Sheets READ ME in the app folder.

Sequence >

 Movie To Sequence >
 Sequence To Movie
 Apply Actions To Movie 
 Apply Actions To Sequence
 Blend Sequence / Movie

This controls some of Compositor's more powerful features. 

BE AWARE:  OS X Finder allows you to “hide” suffix information. If you have this 
preference chosen, and you delete a suffix, and then try to use such file in 
Compositor, which sees the true filename, you won’t get good results, as the 
suffix isn’t deleted, but simply hidden. Bad weird thing, but the best fix is to 
have the Finder Preference set to Always Show File Extensions.

Doesn’t it stink that we even need these now?

Operation: 

Movie To Sequence has 2 options...using Quicktime formats, or fast PICTs.

The Quicktime options allows for more image formats, and a different naming 
convention. Choose your destination format,  and any options you wish, then 



set the sequence base name, preferably one word, such as "Image" or 
"Sequence", the program and Quicktime will number them correctly as the 
movie is disassembled.

I have noted that the Quicktime image exporter takes progressively longer as 
the movie is decompiled to images, so I added a faster manual disassembly 
which sets things to PICT format, and is a lot faster. Speedy.  Choose the 
movie, then choose the sequence base name and folder. The name here will be 
as  basename.0001, basename.0002, etc.

Apply Actions To Movie

Cool!  This feature is much more robust as of v2.2, and was previously located 
under the Image Menu. For strange movies with weird timescales, or those 
which you notice problems with otherwise, such as missed frames (some MPEG 
visual layer movies will suffer from this), check "Use Existing" for the Frame 
Rate option. That should cure it.  Space Bar, ESC or Command-Period to cancel 
the operation when in progress.

Apply Actions To Sequence

This will apply your chosen actions file to a numbered image sequence. The 
resulting images will have "ATS_" appended to the front of the name of the 
original. So, My_Image.001 will become ATS_MyImage.001 afterward, leaving 
the original untouched. Follow the steps in the dialog. Choose the -last- image 
you wish to use in the file dialog. Compositor will count up from 1 to there.  
Space Bar, ESC or Command-Period to cancel (also perhaps mouse button)

Blend Sequence.../Blend Movie...

This  feature, inspired by Dragonfly Digital Design's FrameBlender plugin for 
Quicktime and Photoshop™ , will blend all source images into a single frame. 
You can cancel the process with a mouse click to get. You can use this to track 
motion trails for strange video anomalies. A UFO buff's dream. Or the 
Compositing Image Artist's handy tool for source material.

The main original use it was designed for is to reduce noise by averaging it out 
over multiple frames. So you can take a still sequence video clip (where the 
camera does not move) and blend the result into an image which has more 
detail and clarity than just one image grab would give you otherwise.



I like it for the artistic uses. Also, for tracking strange things, like objects in the 
space shuttle video from mission STS-48. 

For Blend Sequence: Choose the -last- image you wish to use in the file dialog. 
Compositor will count up from 1 to that choice. Space Bar, ESC or Command-
Period to cancel (also perhaps mouse button)

Page Setup
Print

Mac users will find these familiar. Page Setup will let you set the basic layout 
options, and Print will print your image. Compositor can scale an oversized 
image to fit the page automatically and will give you a choice to do so. Choose 
that option if you wish.

All print testing has been done with an Epson Stylus Photo 700 and Epson 
740U. If you encounter problems and you believe it to be Compositor and not 
the printer driver, please contact the program author at artlythere@kagi.com

Printing with v2.5 should be much better behaved and offer true resolution 
changes over the prior versions.

Quit

Stop It All. Command-Q works for this as Mac standard. Prefs are written to 
disk, temp files are disposed of, and Compositor tidies up and quits. Any 
Compositor temp files are also checked for and disposed on program start up, 
or moved to the application folder if the program thinks a crash occurred. You 
can import these using File/Import/Compositor Raw. Save them as a more usual 
format afterwards.

Edit Menu  and Select Menu (Tool Mode)

Undo Image
Undo Drag

Cut
Copy >



Paste/V
Paste Using >
Paste Into >

Clear

Crop

Swap Clipboard

Preferences

(There’s more work to do in the undo depts, it’s on the list)

Undo Image undoes the latest image  operation. Choose it again to Re-Do.  
operation of the selection frame (view rect). If you have just done a Fade 
Last... operation, you can undo that to the original before-filter status with 
Undo Image.

Undo Move undoes the last drag of the frame, or selection. If you have resized 
it, or moved it and you want it back the way you had it before, choose this. 
Choose it again to Re-Do. You can undo a drag or resize even if you have 
applied 40 filter operations. The Spazoid Filter, which goes to town all over the 
image via the frame wipes the frame undo buffer and resets the frame to the 
full image size upon exit. This negates any Undo Move ability.

There may be some tidy up to do here with the advent of version 2.0. The 
Undo engine is quite different than in previous versions.

Copy Current

This copies the current Image, or the current selection, or only what is in the 
frame rect, depending on Mode.

Copy Window

This copies the whole window contents at any time.



Paste

Pastes into any active selection or current frame.  If the selection is floating, it 
is replaced by the new paste.

If the contents of the clipboard are of a different height and width than the 
current selection or frame, the image is scaled to fit. 

To paste an image as other than a floating selection, press the option key while 
choosing the menu item.

Paste Using  Submenu

Differences
Pastes into the selection frame the difference (subtracted) contents of the 
clipboard and the current image. If the images are identical, the resulting paste 
will be black. The colors can get interesting quickly with this command, and 
filter operations. Experiment. Fade Undo. Re-filter. Have fun.

Lighter
Darker

Pastes only the lighter or darker pixels using an absolute measure, no blending. 
Pixels lighter or darker in the clipboard image overwrite the original.

Blend
Blended Lighter
Blended Darker

These will blend the clipboard image and original image pixels instead of just 
overwriting one or the other.

Black Mask
White Mask

Black Mask will paste any colors in the clipboard image that are not pure black, 
luminosity of 0.
White Mask will paste any colors in the clipboard image that are not pure white, 
luminosity of 255.



Red Channel
Green Channel
Blue Channel

Pastes only the channel above from the Clipboard image into the target image.

Not Red
Not Green
Not Blue

Pastes the two remaining channels from the Clipboard image -other- than these 
into the target image, leaving the specified as the only remaining original 
channel.

High Pass Blend

Uses the same engine as the High Pass filter in the Artly There menu, but as a 
paste.

Subtract A
Subtract B

This subtracts the clipboard contents from the current image, or vice versa. If 
you hold down the option key, the values will wrap around  instead of being 
clipped if they are less than zero.

Hue
Saturation
Luminosity

These choices allow you to paste only a component of the clipboard contents 
into the current image.
You can get some interesting results with these.

Paste Into

Pastes into the selection frame the contents of the clipboard and the current 
image if the current image matches your color choice plus a fuzzy factor of 
128 (50%).



Works for a nice effect sometimes.

NOTE:  If choosing Paste Into Alpha Channel, then you have the option of 
creating a selection at the same time according to the preference check item 
you can set just below.

Swap ClipBoard

Handy dandy...swaps the clipboard image with the current canvas. Using this 
one can scale a portion of image easily. See the Quick Tips item in the 
Compositor Help menu.

Preferences   (under Application menu in OS X)

Allows you to set basic Compositor Preferences.

Please click and hold the Popup-Help icon for an on-the-spot guide.

The Last Chow option tracks your last actions. If you forget to save something 
cool, grab that file quick and rename it. :)

Select Menu

Select All/A
Select None/D
Invert Selection
Float Selection
Clear Floating
Fill Selection
Stroke Selection
Toggle Selection Edges/H
Feather Selection…/G

Save Selection...
Load Selection…

The below menu choices are only available when in Tool Mode.



Select All/A

Selects the entire image, making it the active selection. Unlike other programs 
you don't need to do this to copy things in Compositor. But you do if you wish 
to delete an image quickly to the background color, using Delete or Clear.

Select None/D

De-Selects any current selection. If things get strange with selections during 
program operation at any time, select all followed by select none will usually fix 
it. This is hopefully behavior that will fade as the program's entirely new 
selections engine is debugged.

Invert Selection

Invert Selection reverses the selection mask for the current image, and remaps 
the region, and the "marching ants" used to display an active selection.

If you have a square in the middle of the image, and you choose this, the new 
selection will be the entire image, less that square.

Float Selection

This is the menu equivalent of Option-dragging any current non-floating 
selection.  A floating selection is one where the contents moves with the 
selection.

Clear Floating

This clears the contents of any floating selection present, defloating the outline 
also, so that you now have just the selection. Handy when you want the 
selection still after a paste operation...perhaps you wanted to drop a copy of 
the selection contents by Option dragging...now you want the selection to 
remain so you can filter over it. This makes that easy.

Fill Selection

This fills any  non-floating selection with the current forecolor.



Stroke Selection

This outlines any current selection outline. The outline is not smoothed at time 
of this writing..(anti-aliased) however you can Feather a selection to a 2 radius, 
use Image/Invert back and forth once or twice...then fill the gray area using 
Replace color dialog, or paint it in using that blend mode and the paint brush. 

Hide Selection Edges/H

Toggles the visibility of the "marching ants" which are animated to show a 
selected area. Choose again to Show.

Feather Selection…/G

Feather selection  is a quite nice feature of Compositor. This "fuzzes" out the 
edges, or blurs the current selection mask, allowing for neat effects, or nice 
blends of copied or pasted selections.

Example: Select an oval area using the Select Oval tool...Copy it afterward 
(Command-C). Feather Selection to radius of 5...choose a background color you 
like for a glow...Edit/ Clear or Delete Key a time or two... Now Select None. 
Paste back in your oval...position it back over the original area if necessary. 
Now you have a glow surrounding your area of choice. Cool!

Save Selection...

Saves any current selection for later re-use. Best to place it into the Selections 
folder that Compositor maintains.

Load Selection...

This will load a selection file into the current image. Selections work best when 
applied to the same sized image they originated from.

Alpha Channels...

Please read the Alpha Channel Read Me in the main application folder for more 
information. A tutorial is forthcoming.



Frame Menu

The Color Choices

I will skip the colors listed there and concentrate on the general specifics. :) 
Wow, that is a good one. General Specifics. Your wide-ranging details.

This does two things. It sets the color of the view frame, selection frame, drag 
rect, image view outline, whatever you end up calling it, and allows you to 
Stroke Frame or paint that color frame onto your image. It also changes the 
text color of the Show Info option.

Wahoo. That was easy. 

The frame is currently only one pixel wide at all times, except when the image 
is zoomed out. In that case it is enlarged a bit. (Zooming in-out in Frame and 
Mat mode may not be enabled as of this writing, v2.0)

You can choose the preset colors, or a whole new one with the Custom... 
choice.

You can also Stamp Mat Color , or choose the Mat Color, when in Compositor 
Mode. Average To Mat can be used to set the color to the average color of all 
the pixels in the image when in Compositor Mode.

When using Stamp Mat, the Option Key and this choice will stamp the mat 
color, and then stroke the frame color too.

Options SubMenu

Menu Commands are:

Auto Shrink
Reset Frame 
Hide Frame
Use Ratio
Show Info
Hide Cursor



Think of these as non-dialog windowed "preferences". Any choice here is stored 
across restarts of the machine and application.

Auto Shrink

By default Auto Shrink is enabled. If this is on, you can shrink the view rect 
(selection frame) automatically by dragging within it, and "bonking" it or 
pushing it against a window side. If Use Ratio is enabled, it will shrink in 
proportion. If Auto Shrink is OFF and Use Ratio is enabled, the image frame may 
appear to be locked. You must manually resize the frame then. If Use Ratio is 
OFF then you can drag the frame outside the window confines. If you do this, 
and a portion of the frame appears to be out of bounds, you can choose Reset 
Frame to reset it. Otherwise a Save at this point will crop the frame to the 
viewable portion.

Contact the author regarding any bugs in this area, changes as of v2.0 may 
have bypassed some items.

Reset Frame 

This command is your pal. Use it to reset the selection frame to what is 
normally thought of as a Select All situation ( as when in Tool Mode).

If you somehow lose the drag frame outside the window, then this will restore it 
for you. If you somehow shrink it down to the minimum 10 x 10 pixel size 
allowed, you can reset it quick this way.

This command will fix any strange situations you may find your frame to be 
involved in. Since it resets to a "Select All" situation, it may cause a few irks 
too, such as when turning Use Ratio on, which resets the frame to the max 
dimension of the current proportion. Turning that on calls the Reset Frame 
command after the reset of the proportion. No problem.

Stop sweating already.

Hide Frame

Wipes it out of existence, visually. It is still there of course.  The Frame is 
locked when it is hidden. It can still be dragged invisibly, but will pop back to the 
starting frame once it is unhidden or the mouse is back up.



To re-show your frame, choose this again.

Use Ratio

The Secret To All Compositor and Compositor Mode, at least in Frame and Mat 
modes. Ok, that sounds grandiose. What it does is keep the frame in the 
current proportion of the image, or a custom one. You can set that with the 
Ratio Menu. If you have this off, and then enable it, the frame will resize to the 
largest size allowed by the current ratio. May be rude, but there for a reason. I 
forget just what right now. 

Show Info

When this is enabled, 2 items are shown in the image window when a drag 
occurs in Frame and Mat mode.

This allows you via printout in the lower left corner to see the current 
placement of the top left corner of the drag frame, and the current dimensions 
of it, in height and width.

Example:
13,49
200,140

In this case, the top numbers are the location of the top-left corner of the 
current frame.
The bottom numbers are the frame's size in Width, and Height.

So to place the current selection at 40,50 top-left and 140, 150 bottom right, 
or 100 x 100 in size, you would scale the frame to read at 100 x 100 in size 
then move the frame by dragging in the center of it, until the top line read 
40,50. If you are having a hard time getting the right dimension, make sure Use 
Ratio is OFF.  Or for this particular example, turn it ON and choose 1:1 ratio 
setting.  Easy peasy.

The color for the Show Info text is set via the Frame menu color setting. 
Usually the color wheel opposite or close.

Hide Cursor



Sometimes when dragging in Compositor Mode or any other time, you may wish 
to hide the cursor so as to see unfettered, your complete image view. This 
hides the cursor during drags. Only then. Handy dandy. Or useless, if you are 
my head beta tester, who never saw the benefit. I curse him. :) Oh, hi.

This menu was relocated to the Frame Menu as a submenu with version 2.0.

Ratio SubMenu

Oh my goodness, it's The Secret To All Compositor and Compositor Mode, at 
least in Frame and Mat mode.

Nah. But it is convenient. This allows you to set the selection frame, drag rect 
image view outline , whatever you end up calling it to a set proportion. The 
default is the one that the image opened to. You can however set to a custom 
one.

To swap H-V for V-H when Use Ratio is enabled, changing the frame 
dimensions, Option-Click within the image view or use the keyboard shortcut, 
"t" or "T".

This will not work if the current ratio is set to Natural. To use the natural ratio 
in that way however, choose Custom... and the natural dimensions will be pre-
installed into the fields. Choose "Yep" and now you are good to go.

The preset ratio's are identical to any of a number of common canvas and 
photographic image proportions.

If there is one you do not see as a match because you are experimental or 
metric, or otherwise non-Compositerized, you can set it in the Custom... dialog.

Image Menu

Fade Last

Levels...



Autolevels
Curves...
Brightness-Contrast...
Adjust HSL...
Adjust Gamma... (Void as of v2.7, see Levels)
Replace Color...
Show Histogram...
Channel >

Flip Horizontal
Flip Vertical
Rotate Image...
Scale Image...
Stretch Canvas...

ReMap >
Enhance >
Self Compare
Minimum
Median
Median Smooth
Maximum
Multiply

Multi

Quick Colorize...

Desaturate
Color To Gray

Actions>
Load Actions
Save Actions
Clear Actions
Apply Actions To Movie (See File/Sequence menu)

This will take decades. :)



Hope not.

The Image Menu is The  Image Menu. Items here will typically deal with changes 
to the image map, and are not necessarily creative additions such as the 
FilterVille items, which whack the pixel map in places or otherwise distort the 
image. They deal with the information already there and alter it. This menu is a 
powerhouse, and often the starting place for alterations before FilterVille takes 
over. It also mediates between the source image and FilterVille via the Fade 
Last... dialog.

Other than that, some are there because that is the way things are done in 
other applications.  Where is that infernal beta tester?  I have a complex now.

Number one on the list...

Fade Last...

As I mentioned above this mediates the effects of FilterVille and the Image 
Menu itself via the Fade Last dialog. Heck, it mediates the whole Compositor 
World.

Any image change you make can be faded between what you had before and 
what you ended up with. If you have just run the World Series of Actions on a 
picture, you can fade between the starting image, and what you re-acted. 

If you just ran a filter and you fade between the two by 50 percent (the middle 
default) and decide you hate it all, even after applying that blend, you can just 
choose Undo in the Edit Menu and be back to the before filter starting point. 
Handy.

To use Fade Last... choose the item and a dialog will pop up. You will see a 
handy little copy of the main image in the middle. It is actually a slider button. 
Now to see the original before a filter or other thing was applied (like a paste), 
slide it to the right. To see the changed version in full strength , slide to the 
left.

If you are right in the middle you will see the same red blip bar as when the 
dialog opens. This lets you know you are right back in the middle. Using a 50/
50 blend of source and filtered image.



If you like what you see, choose Okay. Otherwise, cancel. Or Undo. If Okay, 
then the resulting image will be a blend of the proportions you slider'ed the 
slider to. 

Easy. Advanced. Cool. 

Well, I like it.

Levels and Autolevels

Dialog we have all come to know and love via other image applications. Allows 
you to set the black, midrange (gray) and white points in the image either 
together or by channel. Auto Levels uses a percentile algorithm to adjust the 
image extremes.  GAMMA is now handled by the Levels dialog (as of v2.7) as it 
gives a readout and is much more flexible here. You can use the various color 
pickers to set the black , gray and white points.

To remove a color cast for example, find a pixel that should be neutral gray and 
click with the gray dropper on that. The image will be adjusted to take out the 
color cast. For an image that is not white balanced enough, using the white 
dropper, click on a pixel that should be pure white, and the image will be 
rebalanced. You can do the same for black.

Curves

Dialog we have all come to know and love via other image applications, but only 
in a very few good ones. And this one is good. Curves will allow you to do 
adjustments you can not accomplish via Levels command. 

Add a knot (up to 18) by clicking on the curve. Remove  knot by command-click 
or dragging it out of the curve area. See the curve help window or more 
information.

Brightness - Contrast

Dialog we have all come to know and love via other image applications.

The middle mark bisects the slider thumb. Click on or near it to adjust that 
parameter. 



You can choose whether your brightness and contrast applications go to all 3 of 
the image RGB channels, or to any combination in particular.

You can also change the brightness of the channels individually with the 
Chantrast filter in the Channel Whack section of FilterVille. 

Adjust HSL

Changes the image from the normal Compositor RGB mode to Hue Saturation 
and Lightness (or Level).
This allows for a different approach to color adjustments.

Options for input of only certain channels are there. This feature may be 
expanded in the future to allow for all 6 sectors of the color slice in HSL mode.

This adjustment may be slow on a large image. Command-Period will cancel it 
midstream if you wish.

Adjust Gamma

This feature lightens or darkens the image while keeping the extremes safe.  
Not a real good explanation. Basically, you are adjusting the black levels in the 
image.

 Whole papers have been written on the various issues of Gamma. I call the 
function TobascoDeGamma and don't worry about it. It works. 

Handy for PC images where the monitor gamma's are different.  Very speedy 
thanks to Robert Purves, Mr. Optimization. In need of a more informational 
upgrade...will be soon (time of writing is v2.0)

Replace Color

My favorite addition to Compositor way back when. Now improved greatly with 
more features and a new algorithm for HSL.

This intuitive dialog (I hope ) allows you to select a source color in your image, 
and then select a replacement color from the same image or Colorpicker Dialog 
and apply it to your image. And it won't just replace the target color. There is a 



Fuzz Factor adjustment. This blends in the changes so that they fit in better or 
just plain replace more better. Fuzz Factor of 0 is just a one to one 
replacement. If source is white and replace is black, anything solid white will get 
swapped to black. But if the Fuzz Factor is in the middle, now things less white 
will get swapped to a middle blend of the two. Marvy.

You can choose also the HSL Model as the replacement engine. The 
components can be used singly or together. The Hue setting is more sensitive 
to Fuzz Factor, because images typically have hues that are close together. 
What is interesting is that you can change just a luminosity range, if desired. 
Typically you will wish to use just the Hue, or saturation, leaving Lightness 
alone. JPEGs will be more sensitive to hue changes as they use a perceptual 
method that once Hue changed, make the compression artifacts stand out 
much more. Use RGB mode with overcompressed JPEGs.

New as of v2.7: you can have the option to have the output replaced and also 
created a selection of what was replaced. With the HSL approach, you can 
select things that are otherwise difficult using Compositor's normal selection 
tools.

To open the Colorpicker Dialog just click in the colored rectangle.  To choose a 
color from the image or anywhere (even the dialog background), check the 
cursor button and Click to lock it in when you are ready.

The Dialog opens with the current fore and backcolors as Target and Replace 
colors if you wish.

Write your Congressman. Tell them to Vote Compositor.

Show Histogram....

Compositor creates a window, computes a bit and sticks the result in a 
graphically cool display showing the luminosity values of the image in totality 
from 0 to 255. Click OK to close. Check this out before and after an Equalize or 
Equollide.

Flip Horizontal
Flip Vertical



Flips the image horizontally or vertically. Handy to use Fade Last after these to 
build a mirrored image. This is automated in the Combo section of FilterVille 
with Mirror H-V.

You can make interesting desktop patterns this way.

Scale Image Dialog

The Scale Image dialog allows you to change the size of an image. You have 2 
ways to do this. With filtering or without.

To scale the image, enter the percentage or pixel size into the edit fields, 
depending on your chosen units. If you have Keep Proportions, then changing 
one will compute the other for you.

Filtering:

When scaling down a small percentage, for example, 100 percent to 92 
percent size, filtering should be enabled. If filtering to 50-60 percent of the 
image size or less, then filtering may not be required to achieve nice looking 
results. When filtering is off (None) just Copybits (a Mac toolbox call) handles 
averaging and scaling quite nicely, and this is quite fast compared to a filtered 
scale down.

You can change the resolution of the image by leaving the scale fields as 
normal, and just changing the resolution. This does not add or take away pixels 
at this time, but changes the "ideal" rect of the image, which can affect 
printing size.

Stretch Canvas Dialog

This dialog allows you to expand or contract the current image using a "guide 
square" approach.

The display has a representation of the image in the center square, which we 
shall call the guide square. If you add pixels to the image, they will be added 
equally all around. Offsetting the guide square (click the one you want) will 
mean that no pixels are added to that direction.

If you for example choose the bottom right square, and have added pixels to 



the width and height, they will all be applied to the left and top of the image, 
not the bottom or right.

If you for example choose the bottom left square, and have added pixels to the 
width and height, they will all be applied to the right and top of the image, not 
the bottom or left, and so on with the other choices.

If the new width or height is smaller than the original, Compositor removes 
image pixels depending on how the guide square is set.

Rotate Image Menu

The Rotate Menu allows the standard image rotations of 90 Clockwise, 90 
Counter-Clockwise, and 180 degrees up and over. 

You also have the option of rotating to any arbitrary image angle. This can be 
either normal (plain) or filtered (anti-aliased). You also have the option of post 
process sharpening of none, some, and more.

As for Sharpening, "Some" will give one pass of the Unsharp Mask of Zorro 
filter. "More" will give a pass of Unsharp Mask of More Zorro.

Choose None or Some if you don't know how your image may be affected. 
Helps with tightening the image back up at some angles. If you are doing a 
Bicubic rotation of one pass, you probably don't need any sharpening at all.

Bicubic interpolation will give a superior result, Bi-linear will suit you for most 
occasions where speed is more important. 

Tip:

Avoid rotating your image multiple times at arbitrary angles, as image 
information is lost with each successive rotation. Bi-cubic retains the most 
information during a rotation.

If you rotated an image and you realize the angle wasn't quite right, choose 
Undo and then start over. Do not instead rotate it again, or you will lose image 
detail.



Loss of image information is not a factor when doing rotations of 90 CW, 90 
CCW, and 180 degrees, the pixel bytes and rows are just reshuffled then.

ReMap SubMenu

Invert

Flips the pixels to their inverses. Reverses the image, from positive to negative 
and back around. Immersion plus an Invert is the same as a Photoshop Solarize.

Threshold

Not just a simple lil' mapping to black and white though you do have that 
option. The default is a color Threshold. But you can enable or disable the R G B 
channels.

For Newbies, in computer images, in this use in particular, pixels are composed 
of 3 components, Red , Green, and Blue. In this RGB color space, altering one 
channel affects the others appearance when they are blended back together. 
Commonly they range from 0-255.

0,0,0 is Black. 255,255,255 is White. Threshold filters map to black or white 
that which is above or below the Threshold value.

There are other color spaces such as Hue , Saturation , and Lightness, but this 
model is not used in Compositor as of now.

Anyway the point of this, is that you can enable or disable the different 
channels to get some neat effects.
  
Combine some of the results of Threshold with Emboss and you can get some 
nice color banding.

Posterize

This remaps the colors of the image using discrete steps or levels...You can 
reduce this down to 2.



It is said that the eye can only distinguish 32 contrast levels.  Some images will 
band up faster than others.

This is a good one for use with Median, and others for art-ifying your image.

Flood Fill

This remaps the colors of the image using pixel luminosity. If you have it set to 
darks, then the slider fills from 0 (Black) to lighter as you go. If Lights, then 
from 255 on down. You can mix and match the 2 directions and choose a 
gradient or component approach (RGB).
 

Enhance Submenu >

Equalize

Equalize belongs in the Remap Dept. But was left here for continuity. This will 
stretch the image colors so that the histogram (See Show Histogram, above) 
will reflect a balanced look.  Equollide is a less severe tool similar to this.
Equollide after Immersion and an Invert is Hot Potato's. Wow, new filter name 
for the next version. :)

Equalize All

Equalize All again belongs in the Remap Dept. But was left here to match the 
cousin. This will stretch the image colors so that the histogram (See Show 
Histogram, above) will reflect a balanced look the same as Equalize, but in this 
case, the three channels of the image are analyzed and recomputed 
separately. Works like Requalize on high output.

> Chaverage

This analyzes the totality of the image via channel, and sets the pixels via 
distance from each channel's average RGB value.

The effect is to tone down extremes of one channel over another.

> Channel 128



This analyzes the totality of the image via channel, BUT sets the pixels via 
distance from a middle setpoint of 128 out of 0-255 .

The effect is to tone down extremes of one channel over another in darkness or 
lightness. This will gray up a too dark image, and will darken down a too light 
image. For some images, it will make them just right.

> Equollide

This stretches the image information so that the image has a full range from 
black to white. This effect may or may not be dramatic depending on the 
existing image already having pure black or white pixels.

This filter is handy for adding "pop" back into an image after a dulling of 
contrast filter, such as a blur. it is subject to removal soon, see Auto Levels, 
Auto Balance and Auto Contrast, which improve on this. However, if you just 
need a little stretch, and there’s room to move, this is the one to use. But 
Levels is easier to use now. We’ve outmoded our own filters. Zounds.

> Requalize

This combines a Chaverage followed by an Equollide (FilterVile) for a usually 
nice effect and enhancement.

Auto Balance
Apply with Option key for full strength. This applies an  Auto-Gamma/ Gray pt 
correction for each channel, along with Auto levels, backed off by 50 percent, 
as with Fade last. For images where a color channel =should= be out of balance 
(lot of blue sky for instance) do not apply this. This should however correct a 
color cast quite nicely otherwise. Check out the gray point dropper in Curves or 
Levels also, to correct a color cast.

Auto Contrast
This is similar to Equollide as how it should have been from day one, applied 
with the same percentile count of Auto Levels and then stretched about the 
middle. Equollide regular version uses absolute first darkest and lightest 
pixel...Auto Contrast uses many more on into the histogram for a more 
accurate, with a different stretch algorithm. Does a nice job. Apply with Option 
key for the Auto Levels algorithm, applied Monochromatically. Whichever 



choice was used will be replayed in Actions.

Self Compare

Waka waka. Great helper for starting to make your image a color wonder 
basket. (case?) Seriously, it compares the image to an inversion of itself and 
takes the difference. This is a cyclic filter, after about 6 rotations your image 
will look like the first time you used the filter. I just found that out. Thanks.

Minimum
Median
Median Smooth
Maximum

These filters run a 3 x 3 kernel over the image.  Minimum will darken the image 
as it is replacing the center pixel with the darkest of the 9 in the box.

Median will reduce "shot noise" by replacing the center pixel with the middle 
pixel value of the 9.
Median Smooth is the same as the above, however the above works from a 
copy of the image and this one works on the same image. The result of this is a 
great watercolor effect.

Maximum will lighten the image as the central pixel will get replaced by the 
lighter of the 9 pixels.

All of these may cause image distortion if run repeatedly.

Run the Big G 2 filter in FilterVille's Big G section and then Median and see how 
neato that works.

Multiply

Beta Guy  wanted this moved over to the FilterVille section for some obscure 
reason. 

This filter could also be called Hypotnusian Terror, as this is sort of how it 



works. Anyway, it works.
Often the second application of this filter looks the best. Often, using this too 
much beyond that will whack your image to the point of no return. You will live 
in Revert City, and feed there often.

This is Beta Guy's  favorite filter effect. Me, I am just proud of what it does. 

It can work miracles though at times. But since I wrote the application and know 
all the little tricks, I have avoided the seduction of The Hypotnusian Terror.

Let it entice you, but do not become it's victim.

Multi

Multi Multi Multi
 
Open the dialog. Choose how many copies of your image you wish to see in one 
row across. Compositor will handle the vertical calculation.

Don't go too crazy here as the copies will get really  small.
You can enter a size in pixels for the spacing between each copy and the next.

Handy for making wallet size photo's I suppose. Beta Guy  wanted this called 
Tile. He wants a lot. But he’s probably right.

Quick Colorize

This is a quick interface to some of the 53 channel operations in the Channel 
Whack section of FilterVille.
It allows you 5 quick choices that are commonly useful in artsy-fizing your 
image.

If you liked that last mangling of English, you will appreciate the names in the 
submenu.

There is also a nice new feature as of v1.2 called Channel Zap. Should be called 
Channel Remap, but Zap sounds more dramatic. You get 3 rows of your R G B 
channels and the choices you can instantly remap them too.



With this you can actually make split channel sub-images of your master image 
by setting all channels to the value for R or G or B, or map other channels to 
another, or blacken or whiten them.

Cool! :) Try out also Split To Channels, with Recombine for nice effects.  As of 
version 2.0, there are 2 new additions to the Swap Red and Blue option in Quick 
Colorize: Swap Red and Green, Swap Blue and Green.

Desaturate

This uses the HSL model in Compositor to wipe out the saturation and hue in 
your image leaving the luminosity unchanged. Paste Differences to with the 
below and note the difference it can make.

Color To Gray

This choice converts your color image to grayscale using a weighted approach 
optimized for modern monitor phosphors.

Actions... are now found in their own submenu as of version 2.0

Load Actions
Save Actions
Clear Actions

The heart of the Compositor "Robo Beast".

Going to go a little in Reverse here. 

Save Actions is where it all begins. Any time you do anything in Compositor it is 
recorded. There are a few important exceptions. Revert is not recorded. Save is 
not recorded. But New With Current is.

All Filter actions are recorded, even the Fade Last... (if one is not, then that is 
a bug, contact me)

You are asked to save your actions whenever you save the source image. You 



are asked to save the actions when you do a Revert as well.

You can save your actions at any time by choosing the Save Actions command.

You can clear the Actions Buffer at any time by choosing Clear Actions.

Load Actions will reload your file and begin the replay instantly.

If you don't want to wait until the playing completes or see an effect you wish 
to stop near, hit the space bar or the ESC key. The 
 
playback speed may be set beforehand using the Mode Menu.

Even Undo's will replay. If you trade with someone else, they may see your 
experimentalism. :) Fret not.

In the future, a Purge Undo's option will be in the Save Actions dialog. Will make 
for super smooth playback then.

Originally I had Undo's skipped during replay, but there became some problems 
implementing the Undo in recording. 

So the Undo became an action unto itself as well. Until the the purge feature is 
implemented you may see "My Friend Flicker". (horrible pun)

Apply Actions To Movie

This feature has been moved to the File menu Sequence submenu as of v2.2

Phewwww. That was a long menu. Oh no, there is still FilterVille...

FilterVille Menu

Where the action is.

At the top of the FilterVille menu is an item called Last Filter.  (First, but last. 



:) )

If you have just applied a filter, this will reapply it using the last parameters, if 
those are limited to say, the option key. However, it will just bring up the dialog 
again for complicated filters, this version at least. Last Filter will re-apply Drop 
Shadow using the last parameters, because that one is one the author uses a 
lot, and can see a need for instant replay. The others commonly may wish for 
more input.

Command-F for this as a keyboard shortcut.

Near the top of the FilterVille menu is the Custom Filter.

This is a powerful filter. It is a 3 x 3 kernel filter. 

That is, it moves a box filter of 9 pixels total across the image, each using the 
weights input.

When you place a number in a field, that is the weight given to that pixel. 
Compositor totals the weights of the fields automatically to get the divisor. 
Generally you want them to add up to 1. However this isn't always necessary. 

Use the Rotate button to cycle the values around the edges...this will alter the 
way the filter is applied to the image directionally.

There are two mode applications to this filter. 

Apply To Same gets from the source image and applies the changed pixel to 
that source image. The changes get carried on downstream so to speak. 

Apply To Copy gets from a copy of the source image and sends the changed 
pixel back to the source image. The water is always fresh to so to speak.

Absolute insures that any pixel value is clipped to either black or white if it is 
out of range. Sometimes this helps a filter to look better or worse. Experiment. 
Sometimes a setting in the fields will black out the image when this is not 
checked, but work if it is. Or vice versa.

The center field corresponds to the main pixel of this 3 x 3 box filter. 



Experiment with different settings for the kernel using Apply To Same, and 
Apply To Copy. The differences can be surprising. And artistic.

An example Sharpen filter is below. Apply To Same or Apply To Copy.

  0   -1     0
-1     8   -1
  0   -1     0

  0     1     0
  1     2     1
  0     1     0

The above would be a blur effect. Apply To Same or Apply To Copy.

This would be a Color Emboss. Apply To Copy.

  -1    -1     0
  -1      2     1
    0      1     1

The more you weight the center pixel, the less the apparent effect.

That should get you started. Experiment. The worst that can happen is that you 
have to undo it.

Custom Filter settings are saved across restarts. For best results, save and 
load your custom settings to the folder of your choice though.

The default is a simple light blur.

Sharpen Submenu

Sharpen
Sharpen More
Sharpen Edges
Unsharp Mask of Zorro



Unsharp Mask of More Zorro

Sharpen is a preset of the custom filter. This will do a light sharpen effect. This 
won't ever destroy your image unless you apply it a few times too many.

Sharpen More is two passes of the Sharpen filter.

Sharpen Edges applies the Sharpen filter using a special discriminator so that 
edges receive a biased amount of the Sharpen effect.

Unsharp Mask of Zorro

This filter applies a custom sharpen setting to the image, and then recombines 
the resulting image with a copy of the source. This helps soften the effect.

Unsharp Mask of More Zorro

This filter also applies a custom sharpen setting to the image, and then 
recombines the resulting image with a copy of the source. It does more 
sharpening though.

Dear Compositor,

We here at the Movie Studio resent your use of the Zorro name in your Filter. 
Please Cease and Desist.

Okay.

Antonio said I could use it, but I guess since he made you the millions, that 
doesn't mean squat. I live on recycled pennies, but you go right ahead and bully 
me around. And the users of this fine application.

Signed,
Author

Sharpen Lites Only
Sharpen Darks Only



These sharpen only the colors in the image that are above or below a certain 
luminosity value (128 out of 255).

Blur Submenu

Blur
Blur More
Variant >
  Blur Edges
  Blur Right
  Blur Down
  Blur Combi

Rude Blur
Rude More Horizontal
Rude More Vertical
-
Blur Lites
Blur Darks
-
Gaussian Blur
Zoom Blur

I am going to condense the descriptions here.

They should all be fairly clear once used.

Blur More is Blur done twice.
Blur Edges biases the blur toward contrasts which may occur at edges of 
colors.
Blur Right blurs to the right.
Blur Down blurs down.

To use a right or down in a different direction, flip the image. Blur it, then re-
flip it back.

Blur Combi is a combo of right and down, and is like a double Blur More.
A nice effect.



Rude Blur is like a wind shear with coloration effects.

Rude More Horizontal  converts random length lines of pixels to the average 
color of the line, horizontal fashion.

Rude More Vertical   converts random length lines of pixels to the average color 
of the line, vertical fashion.

Blur Lites Only
Blur Darks Only

These blur only the colors in the image that are above or below a certain 
luminosity value (128 out of 255).

Gaussian Blur

This blurs the image using a bell shaped curve filter. Works marvy. Can choose 
options of vertical or horizontal, or Omni, which is a combination of the two.

Speed varies with radius chosen. Works very nice though. For less blur than this 
can provide at radius 1, use Fade Last in combination with it, or instead use 
Blur or the Custom Filter instead.

Zoom Blur

A Zoom in filter...distance set by slider, and various applications can be chosen. 
Drag the Preview (option-drag for more speed) to set the center/Origin point. 

Tripping makes echos. The others allow for smoothing via bi-linear 
interpolation, or simple (faster) blend.

Choice of Horizontal, Vertical, or regular Omni. Way cool!

Motion Blur

Motion Blur....set the angle using the angle widget, choose the noise option for 
a bit more texture. Longer distances take more time.



Distort Submenu

Ripple Waves
Spherize
Twirl

Ripple Waves 
“Preview Is Origin”  means that the preview sets the ripples origin, drag it to 
set. Option drag for 2x the speed.
Set the wavelength (distance between waves) , the Amplitude (the height, or 
distortion of each along its radius) and the Phase, which offsets the wave 
fronts.

Spherize
Set Frosty option for a nice artsy effect, otherwise choose the distortion 
amount.

Twirl
Twirl spins the center of the image. If Whole Image is not selected then the 
effect will be limited to the shortest axis of the image, otherwise the entire 
image will be spun around center.

Average Submenu

Average
H Average
V Average
H-V Average

Cell Average...
Average To Mat

Average totals up all the RGB values in the image, averages that, then fills in 
the image with the resulting RGB color.

H (horizontal) Average averages only in the across direction, by row.

V (vertical) Average averages in the up-down direction by row.



H-V Average Blend is a blend of the two.

Using Contrast upon any of the three above can make for some neat "pipe" 
effects.

Cell Average...

A cell here refers to the square size to be averaged and filled. You choose from 
2 to 64 in size.

This will give a pixelate effect more pronounced than the 3x3 Pixelate in the 
Pixel Whack Submenu.

You can instead of filling a square with a square of the color average, use a 
circle to fill the square.

Circles seem to look best when at a cell size of 8 or below. This filter is similar 
to Photoshop's "Mosaic" filter.

Average To Mat

Compositor Mat Mode Only.

Averages the entire image or portion of the image and sets the Mat / 
Background color in Compositor Mode to that color. You can also change the 
mat color from the Frame Menu.

Artly There Submenu

DuoWave Filter...

This here puppy is mighty fine. You can distort your image like crazy. Can apply 
as Horizontal or Vertical.
Can choose between SIN and COS interpolations, and the modifier as being X or 
Y. Easier seen than described.

Settings aren't saved across program restarts currently, but I will add that 
soon. Write down your favorite ones until then. DuoWave currently sets out of 
range pixels to black.



I think this filter alone is worth the price of Compositor!  Anti-aliases the image 
too.

Spiral and Ripple coming up when I get them working nicer. 

TV Scan Filter...

This is much like the popular aftermarket add-on RetroScan by Deep Devices 
(for Photoshop). This offers some new options however. Ramp Edges is left out, 
but Tape Dropouts, and adjustable Ghost-shift, as well as channels for the 
Ghost image are there.

There is also a choice of just lightening the image by scanline, or darkening : 
my modes, or lightening and darkening at the same time like RetroScan.

This however isn't extra like a plugin, and comes with Compositor for the 
registration fee.

Luminous Edges

This is the same as a combo filter that applies a Find Edges, blurs that result, 
then EQ's it some, and finally blends it back in to the main image. Spiff.

Soften Image

Handy image softener. Applies automatically for you a Gaussian blur of about 
radius 3 and then a Fade Last of 50%. Works nicely, particularly when 
combined with a Luminous Edges.

High Pass...

This filter is the equivalent of the Photoshop™ favorite...useful for filtering 
images, particularly those from NASA images of Mars, etc. 

It can also do some really ethereal effects with images of people, particularly if 
they are on a dark background (low frequency information is filtered out). The 
smaller the radius, the more extreme the effect. The higher the radius, the less 
extreme the effect, at the expense of time.



Unsharp Mask...

This is a sharpening/contrast enhancement filter. It will be upgraded for more 
options soon (planned, time of writing is v2.0)

It uses a difference of blurred and original images.

Drop Shadow...

One of the author's favorites. Unlike previous filters  that I have seen which do 
the same (older versions of Alien Skin's for instance) this one leaves your 
selection intact.

If there is a floating selection the Drop Shadow filter will leave a copy of that 
floating contents on top of the shadow.

Otherwise, it leaves a shadow delimited by the current selection (or Frame, in 
Mat or Frame Mode)

Drop Shadow re-applies using the last parameters if called forth by the Last 
Filter choice (Command-F)

Choose your preferred color of Black , Foreground or Background...For a glow 
around a selection, set the blur radius to 5 or more, and leave it centered at 
0,0 for x and y displacements. 

Apply Luminosity Map...

One of the best new features in Compositor since the program was introduced. 
Load a 256 x 256 Image map (PICT format) and then click and drag, click, or 
choose scan to see the application of the colors in the map to the target 
image, using luminosity of the image pixel as the criteria. You can see beneath 
the map how lighter or darker pixels in the main image are getting the new 
coloration from the map.

What is cool, is that choosing OPTION key + Scan allows you to make a movie 
of the "Scanimation". Click to stop before too long, or you may overrun your 
hard drive. The movie is compressed using a baseline RLE compression, and a 
default FPS value. Quicktime is required.



You can alter the map and save any changes, which is recommended, since 
replaying actions with a map application will prompt you to find the original 
map. If the changes weren't saved, the replay will be altered accordingly.

Channel Whack Submenu

Channel Changer...
Fast Zap...
Chantrast

The way to creating cool color effects quickly is via the Channel Whack effects.

Chantrast is a channel specific brightness control. To brighten any RGB color 
channel in the image , use this dialog.
This has now become combined within the Brightness-Contrast dialog as of 
v1.5. May be easier to use from there.

Now for the Heart of FilterVille.

Channel Changer...

With these two menu choices, you can go wild. There are 53 preset color 
Channel Whacks. Red is swapped for Green. Green is swapped for Blue. Red is 
moved over a notch. Blue is sent to Boarding School.

Whatever the case, your image will never be the same. On a more serious note, 
this area can really help with some image processing areas that may include 
some scientific and or medical applications.

The channels being moved around turn lights to darks, remove contrast, 
enhance contrast, etc.

I have analyzed some Mars images and the results are interesting.

So to use:

In Order



Just click the arrows to go forward or backward in order, 1 to 53.

Random

Click the arrows to go forward or backward in random order, 1 to 53.

Enter...
You can manually enter the number of the preset you like. 

Different images can appear very different with the same preset because of 
the color distributions. Experiment.

Pixel Whack Submenu

Swap Job
Pixel Go Round
Pixel Blast
Smooth Nuke
Pixelate
Randomizer
Fragment
Rude Beast
Et Tu Beast
Nuke Lites
Nuke Darks 

This menu offers some of the more creative artistic helpers.

Swap Job swaps rows of pixels in the vertical direction, horizontally.

Doing it twice will give you the original image again.

Pixel Go Round rotates pixels in a 3 x 3 kernel. If you do it eight times you get 
the original image back.
Until then, the world is yours.

Pixel Blast is your ticket to good vibrations. It noisifies your image edges and 
works wonders. Sort of am image disruptor.



Smooth Nuke is Pixel Blast on steroids, with some laxative applied. Exactly what 
it is named. It blasts the image, but smoothly. A little slow on larger images but 
worth the wait.

Pixelate  is a basic pixelate effect. Like the TV stations use to hide someone's 
identity. If you need a more pronounced effect than this, go to the Cell 
Average filter in the Blur Submenu. Pixelate centers the effect around the 
central pixel however.

Randomizer  uses the image itself to grab the pixel colors for the noise it 
inserts.

Fragment  takes your image and makes 4 offset blended copies of it. Works like 
Photoshop™ 's Fragment filter (at least the older one) and better around the 
edges,  I believe. 

Rude Beast  takes your image and makes 2 passes of a 45 degree Rude Blur, 
fading the result for you automatically. The result is a nice crosshatched 
artistic look.

Et Tu Beast  takes your image and makes 2 passes of Rude More Blur in a 
combined fashion. Really bugs out the image fast.

Nuke Lites
Nuke Darks

Applies Smooth Nuke to these brightnesses only.

Combo Submenu

Dark Painting
Water Painting
Chunky Painting
Spunky Painting
Mirror H-V
Shower Glass
Smear Canvas
Pixel Libation



Plasticizer
Aldo Fresco
Posterica
Inkage
Alumirust
Oil Tanker

These filters offer some really artistic effects. As the name suggests, the 
Combo filters are preset combinations of Compositor's standard feature set. 
Some are custom coded however.

Dark Painting works well when there are some lights in the image.

Water Painting adds some flicks of colors while softening the image and 
removing noise.

Chunky Painting adds some Invert Half, Rude Beast, some channel works, and 
Median Smooth. For Impressionistic Art lovers.

Spunky Painting adds some of Chunky Painting plus some Channel Whacks. For 
Impressionistic Art lovers.

Mirror H-V  makes a symmetrical masterpiece of your image. Probably good to 
bump up the contrast a bit after running this one. Great for making Desktop 
Patterns.

Shower Glass gives the impression that you are looking at your image through 
blurry glass.

Canvioli does the heebie jeebie on your image. For Impressionistic Art lovers.

Smear Canvas does the heebie jeebie on your image. For Impressionistic Art 
lovers.

Pixel Libation does a double heebie jeebie on your image, though not the same 
way as the Smear Canvas.
Often, just this one filter will turn your image into a nice impressionistic 
interpretation.

Plasticizer does multiple transforms on your image, leaving it with a vacuum 



formed plastic look.
This uses Equalize, so doing a portion of your image may yield a different result 
than the whole.

Aldo Fresco (Fresco) does multiple transforms on your image, leaving it with a 
faded plastered look.
This uses Equalize also, so doing a portion of your image may again yield a 
different result than the whole.

Posterica does a Posterize of your image, and outlines any color changes. Black 
is the normal outline color. Press the Control Key while choosing this filter to 
change the outline color to white. For less colors, press the Option Key. In this 
case, the control key is ignored, leaving black as the only outline color choice.

Inkage does a custom Posterized Threshold of your image. It uses a difference 
process than a normal Threshold, and thus may be preferred over Theshold 
alone. Pressing the Option Key while choosing this filter will reverse the 
application of black to white, and white to black.

Alumirust is my favorite new filter. Using Aluminized Edges as a base, it goes 
on to do some more operations and really wild childs your image.

Oil Tanker does some iterations of a custom kernel filter in tandem with some 
median and remixing, for an oil palette effect. Option Key when applying this 
filter will add some additional color back in, along the lines of the Water 
Painting filter results, by leaving the results in regular RGB instead of pasting 
the resulting luminosity channel back into the source image, which clears up 
the color a lot.

Big G Submenu

Here you have 

Big G 1
Big G 2
Big G 3
G 1 Too
G 2 Too
G 3 Too
G Custom



These filters are mighty cool, and can lead to some of the nicer effects 
Compositor can produce.

Remember the Absolute setting with the Custom Filter? These reflect the 
setting as off , and on.

The "Too" filters are Absolute enabled. As a result they don't overflow and 
generate noise. However this noise is what makes them so useful at times. A 
Big G 3 on the proper image looks like the Big Man came down from Heaven 
himself and sneezed Glory all over it.

G Custom is a neat custom kernel that I thought should be a preset. Makes a 
neat contrast embossed colorful light blast.

Big G 1 is a smooth blur washout contrast wiper image brightener.

Big G 2 is a magenta shot blast.

Big G 3 is a particle fountain and molasses light.

The "Too" filters are these with less noise since pixel clipping is enabled.

Big G 3 is my favorite. But G 2 Too can do some smooth magic when the input 
colors are right.

Doing a Median Smooth after a Big G 3 and then doing another Big G 3 can be 
exciting.

It all depends on the input image. Big G 2 on most images will noise it up fierce. 
However when the input colors are to its liking, you get some magic, and some 
great metallic effects. They have some edge finding abilities as well.

Flip your image to smear the effects in other directions.

If using these from the Quick Palette, you can get the "Too" version by 
pressing the Option key while clicking any Big G button.

Edge Submenu



Glowing
Line Art
Contour
Cutout
Aluminized
Bump Up The Jam

Glowing  Finds edges, and makes them glow on a darkened background. You can 
Invert the result for a more sketched look. This is a dual pass summation filter 
that gives a nice result.

Line Art  This is Find Edges (Glowing) using another algorithm, and a single 
pass. Compositor post-inverts the image for you. Not as thorough as the above 
in my opinion, yet for some situations, a better choice. Makes thinner lines for 
one. But it is less contrasty, which makes it not as visible overall. It does yield a 
more "drawn" looking result I think.

Contour Threshold at 128, and then a Line Art. This combines the two.  Use it, 
then Fade Undo, then Self Compare (Image Menu) for a nice effect.

Cutout  When an image has the proper contrast, makes the image look like it is 
cutout and glued onto a white background, somewhat. More accurately, makes 
the image look like is has been relief stamped out of wet white watercolor 
paper.

Aluminized  Plows those image pixels into a cross referenced pseudo-gouraud 
representation. Really funky. An Artly There original. Check out the evolved 
application of this using the Combo filter, Alumirust.

Bump Up The Jam
Adds a nice embossed bump effect...Regular is shadow bumped, Option + the 
filter will give you a hilite bump.
Try both sequentially for a neat effect, perhaps along with the Combo menu’s 
“Plasticize” (back that one off a bit using Fade Last).

Create Submenu

Stars and Planets
Flare 



I can't wait to fill this one up. 

Stars and Planets - New improved as of v1.9

This is easy to use. There are two parameters. Tolerance is how light the colors 
that can get stars can be above black in a lightness sense. Frequency is how 
many stars end up in that color. You will see the biggest change in Frequency 
with values from 70 to 100, because there is a little exponential something 
going on with the Randomizer portion of that calculation. You can apply multiple 
batches of stars. Choose Undo to remove the last application.

Planets...oh my. Select the size and drag your choice to where you want it, 
then let up the mouse. A nice heavenly body will be plopped onto your image. 
Best on background of black, due to masking considerations, though some will 
work elsewhere. Real cool feature I think. Choose Undo to remove last item 
added.

Choose "Done" when done with the dialog and creations.

Flare

Offers 3 sizes of an artificial Flare that you can add to your image. Drag the 
circle in the small version of your image to set the location where you want it 
to appear. Then choose the size.  There is a small buglet at times that I have 
experienced whereas the Flare will not appear. It is rare, and probably relates to 
moving the mouse at the wrong time. Just sigh and try again if that happens. 
(Note:  To the best of knowledge , this problem has been vanquished as of 
v1.6.)

Shade Submenu

With this you can shade the framed area, or the area outside of it, in Frame 
and Mat mode, or any current selection when in Tool Mode. Plain Shading is 
limited to darkening and lightening currently. Toggle the Darken/Lighten menu 
choice more easily by using the "L" key on your keyboard.

In Frame Mode, Shade Mat will shade the image area outside the frame. In Mat 
Mode, Shade Mat will shade the mat color in use at the time (black will show 



nothing) and you will need to switch to Window view or drag the frame around 
to see the results. In Tool Mode, only the image itself, or inside a selection can 
be shaded, the Mat options will be dimmed.

All this can give really interesting results with a little imaginative application. 
See the "Many Demo" file in the Actions folder for some ideas.

Shade Image shades within the frame only, works the same in Frame and Mat 
modes.

You also have the choice of Oval Vignettes. You can choose the quick choices 
of Dark or Lite. You can also make it the color of the current frame or mat.  
You may achieve a faster result when in Tool Mode by using an oval selection, 
then feathering it, selecting the inverse, and filling the selection.

Bucket Submenu

Immersion
Solarize
Emboss...
Color Emboss

Immersion
Inverts the darks of the image. Invert an Immersion result, and what do you 
have? Solarize.

Solarize
Invert an Immersion result, and what do you have? Solarize.
This handles it for you all in one so you don't have to.

Emboss...
Love this one. Like the dialog. You can preview 8 light directions, adjust the 
power of the effect, and the percentage of each channel getting the effect. 
Experiment with this one. You can increase the apparent height of the effect by 
adding some contrast to the image before embossing.

Color Emboss does a color emboss the image. The effect is pretty strong. May 
wish to add a Fade Last... after this one. See the Custom Filter for another 
approach to this.



Poster Emboss is similar to Color Emboss, but does a Threshold on the image.
Mirror Horizontal or Vertical  reflects the image about itself, and blends with 
the original.
 
Paintistic is color representational/abstract filter which can be slow (ESC/
Command-Period/Space Bar to cancel) , as it uses a ZBuffer and 3D cones.

Pointerly is similar but uses fewer cones and is thus faster...the cones are 
drawn over the background color, leaving small painterly backcolor gaps.

Noise Submenu

Add Noise...
Perlin Puffs
Dirty Noise
Invert Half
Destreak > (Submenu)
 
Add Noise...
Nice dialog allows you to add random noise to your image. You can add noise to 
a particular channel too, leaving the others looking Wundebah. Choice of 
random color, or random grayscale noise. The preset of 10 percent is a useful 
start.
This filter plus a TV Scan can make for a nice effect.

Perlin Puffs
Perlin noise with a wide frequency, one octave. Apply using Option + menu 
choice to blend the result with the current, otherwise it overides the original 
image and the noise -is- the image.  

Dirty Noise
Really dirty random noise. May wish to combine with the Fade Last... in the 
Image Menu after using this one.

Invert Half
Potentially useless. Doing this one twice gives you your original image back. 
Inverts every other pixel. Useful for adding noise to an image before a Big G 
filter at times. Gives a diluted less contrasty look also. Great when used with 
Median or Median Smooth on occasion.



Destreak
Three versions area available...Vertical, Horizontal, and Combination. If the 
image has noise in long streaks, this may help. Works well with NASA Mars 
Orbital Camera images. Gives a bit of a high pass with EQ effect.

On a "normal" image, Destreak can add some interesting color patterns for use 
with afterward applications of Self Compare, etc.

Esoteric Submenu

3D Red-Blue
3D Red-Green
Party Dots
TV Scanned
Spazoid
Son of Spazoid
Image To ASCII

3D Red -Blue
3D Red -Green

If you have the glasses, have the fun. Shifts the color channels to give a 3D 
look when the glasses are on. On some images this is really amazing. Can make 
your eyes jump when the image suddenly sets back. Possible in the future: will 
re-map your image onto a 3D object then shift, giving a truly 3D appearance 
where  you can see around the edges a bit. More holo-riffic. Wahoooo. :)

Party Dots
Happy happy filter. Sort of a Cutout filter with those candy sprinkles on top.

TV Scanned
Cheap version of the Artly There Submenu TV Scan filter. Quickie, skips the 
dialog.

Spazoid 
Patent Pending. Maybe. Maybe not. Fun filter. Goes Spazoid all over your image. 
Randomly sets the view rect and applies a random FilterVille Channel Whack 
filter to the image. Click the mouse to stop. Undo Image to recover if need be. 
200 Steps auto-limit.



Son of Spazoid
Patent Pending. Maybe. Maybe not. More Fun filter. Goes Spazoid all over your 
image as above but randomly sets the view rect and randomly applies 4 
FilterVille and Image filters to the image. Click the mouse to stop. Undo Image 
to recover if need be. This is nice for abstract art when combined with 
Luminous Edges.

The filters used are Fragment, Big G Too 3, Multiply, and Smooth Nuke. 280 
Steps auto-limit. Or press the space bar or mouse button to cancel earlier.

Spheroid
Randomly applies the Spherize filter using the frosty effect, plus a hilite using 
the foreground color...Option + Spheroid to turn the hilites off. Great as a 
texture base for the Motion Brush and random lines (negative counts).

Image To ASCII

This analyzes the image using cells and then substitutes an ASCII character 
approximating the luminosity. This will use the Backcolor for the ASCII and the 
Forecolor for the background, though you can use the Option key to swap these 
without changing the current colors.

Image Lab Submenu

Contrast Blur
Boid Lines
Hued of The Lume
Trigotron (Moved to separate slot as of v2.5.3)
Grainy EQN
Grainy EQA
Dark Grainy

Grainy and GrainDaddy (Just kidding)

Contrast Blur creates a contrast mask of your image, then blurs the image 
using only those pixels in the mask. This can actually make things clearer to the 
eye I have found, because it removes noise, and details can then pop out 



better. Handy with some NASA Mars images.

Boid Lines is sort of an Artificial Intelligence brush. Instead of plotting points as 
in standard Boid demonstrations lines are connected to the "Boids" as they fly.

This filter has many key options. The normal choice uses the foreground color 
set to the opacity on the Brush Control palette.

Shift will constrain to the image colors, and out of bounds boids will lick up the 
forecolor.
Option and Control will set to only image colors, or re-use "boided" areas as 
fodder for a more drastic effect.

Hued of The Lume remaps Hue according to the luminosity values in the image. 
Funky! 

If you press the option key when choosing this, Saturation will be bumped up to 
full. This is needed for the effect to be seen in some instances where there is 
no existing saturation.

Grainy EQN
Grainy EQA
Dark Grainy

These filters do some noisy EQ'ing, and mimic film that has been push/pulled 
during processing. Try the Option key for different effects with these.

Trigotron Filters
These remap the image using image values and SIN, COS, or TAN. Some are 
grayscale, others are RGB, and RGB Inverted. They aren't exact mirrors of the 
grayscale filters in the case of the RGB ones, as I adjusted the parameters for 
best artistic coloration.

Video > De-Interlace

This filter will clear up common video capture artifacts from NTSC video, etc. 
where the grabs/clips have 60 scan-line timing by 30/30 (Odd then even) in 



the capture, like from a television. In this case, the image will typically have 
odd fields 1/2 frame ahead of image contained in the even lines. This will cause 
a blurred look in the portions of the image where movement has occurred.

You can reconstitute the image using either Odd, or Even fields, and repair it 
using duplication, or interpolation (best). You also have the option to blend both 
together, and this is a handy artistic filter when used that way on a non-
interlaced image.  The preview for this image is draggable! Other previews will 
have this added when time permits. Some have been there since v1.0 and Artly 
There's technical base has improved since then. The preview here is a testbed.

This concludes the FilterVille category as of November 18, 2002
Compositor Version 2.2

Mode Menu

Tool Mode
Frame Mode
Mat Mode

Scale Input To Screen*

Submenu Replay Speed:
No Replay Delay
Short Delay
Medium Delay
Longest Delay

Fullscreen Display 

Window Menu

Show Tools
Show Brushes
Show Colors
Show Quick-Palette
Show Zoom



-
Show Info
-
< Any Open Image Windows >

Settings in this menu are also remembered across restarts and application runs. 
Visibility varies according to the current Mode.

Mode Menu

Tool Mode

The best mode in the bunch, if you need all the editing power. See the Tools 
section for a complete description.  The Tools palette is only available in Tool 
mode. The Brush Controls and Colors Palette are also only enabled when in Tool 
Mode.

Frame Mode

View for normal editing operations. Everything visible is saved, frame excepted. 
If you wish to save the frame color as an outline in your image at any time, 
choose Stroke Frame in the Color Menu.

Mat Mode

The norm for cropping and seeing only what you want to at any given time.  In 
mat mode, you drag inside the image to resize the frame (If AutoShrink is on, 
manually if not by dragging an edge) In this mode, only what is visible within the 
frame will be saved. Exception: Hold down the Option Key when saving. Then 
the whole window view is saved. This mode was behind the original inspiration 
for Compositor...for help in visualizing what a portion of an image would look 
like when painted at that aspect ratio.

No Replay Delay
Short Delay
Medium Delay
Longest Delay

When replaying Actions files these options will give you a choice of the speed 



that they are carried out. In a future edition of Compositor, the plan is to add a 
transport controls dialog to make all this easier. 

Scale Input To Screen*

Compositor was originally written as a preview and pre-visualisation application 
for artists and photographers. Thus it scaled the input to the screen 
automatically. This option is preferable at times, especially if Memory is tight. 
Just be careful to choose Save As instead of Save, or you will write the smaller 
image in the place of the larger original! (NOTE: When in this mode, the Save 
command was defaulted to Save as Copy a while back, and as of v2.7.2 a 
dialog confirms your choice for additional caution.)

 Choose it if you do not need to work on a full sized version of your image, 
when it is larger than the current screen size. Uncheck it for more advanced 
modes that allow for full sized images, at the expense of speed.

Often one can work in Frame or Mat Mode using a scaled version of your image 
for a faster turnaround, then save those actions, and reload the original at full 
size to run the actions on that image.

Some of the random pixel based filters in Pixel Whack for instance will not 
duplicate completely, nor anything where the filter kernel size is impacted by 
the change in scale between the 2 versions of the image.

Otherwise, you get back out the same as the original. Report any bugs in 
Actions replay to the author at < artlythere@kagi.com >

Full Screen Display

Allows you to see your image as if it were in a slide show, to check 
composition, then return back to work. Shift + G invokes, same will end. Or 
menu choice will invoke.

Other ways to end the Fullscreen display mode are a click, or ESC key, or 
Command-Period.
 

Window Menu



Show Tools

This item is only enabled when in Tool Mode. It displays the Tool Palette. If it is 
visible, the menu wording will be Hide Tools.

Show Brushes

This item is only enabled when in Tool Mode. It displays the Brush Control 
Palette. If it is visible, the menu wording will be Hide Brushes.

Show Colors

This item is only enabled when in Tool Mode. It displays the Color picker Palette. 
If it is visible, the menu wording will be Hide Colors.

Show Quick-Palette

This item is enabled in all modes. It displays the Quick Palette. If it is visible, the 
menu wording will be Hide Quick Palette.

Show Zoom

This item is enabled in all modes. It displays the Zoom Window. If it is visible, 
the menu wording will be Hide Zoom.
The Zoom window will auto-anti-alias the contents if the mouse is not moved 
for a half second or so. If you move it during the process of smoothing, it may 
take a bit, as the cycle cancels in midstream.

Show Selections

This item is enabled in all modes. It displays the Selections Palette. If it is 
visible, the menu wording will be Hide Selections Palette

-
Show Info

This item is enabled in all modes. It displays the info Palette. If it is visible, the 
menu wording will be Hide Info.



Quick Tips

• For faster export of an image sequence from a movie, use the "As PICTs" 
option.

• Until Floating Selections can be filtered, you can try this method.  Copy your 
item, then  just create a new document with New Using Current, apply 
whatever filters you wish, paste the item onto that, then choose the Edit Menu 
Clear Floating, move the selection if needed, Copy it, then paste the result back 
into the image.

• If you have an existing Selection when in Tool Mode, can go to Frame or Mat 
mode, and apply filters there. Come back to Tool Mode, and your selection 
should still be there for more filtering effect choices.

Example: Create an oval selection in Tool Mode. Go to Frame Mode...Invert 
(Image Menu/Remap/Invert), go back to Tool Mode, Invert again. Masked to the 
oval this time. Mix and match, have fun.

• The Frame is �locked when hidden in Frame mode. 

• When the Actions Palette is Paused, clicking Run engages Step mode, for one 
at a time application. However, the undo buffer won't be reloaded in this case 
until the last action is reached.  Pausing or stopping a normal run mode will 
reload the Undo image automatically.

• When using Stamp Mat, the Option Key and this choice will stamp the mat 
color, and also stroke the frame color .

• If you need a larger canvas, you can use the Stretch Canvas dialog under the 
Image Menu. If you have the icon to the left middle, then the extra area will be 
added to the right of the image. Centered, will add it equally to left right, top 
and bottom, and so on. The guide squares choose where pixels are added or 
removed.

• The Option Key on your keyboard is the secret to much of Compositor's 
under the hood operation, the other one being the Control Key. You can move 



the frame in various ways with these, enlarging or shrinking it by side. See 
below.

• Filters act on what is within the frame confines, or non-floating selection 
outlines (currently only non-floating). Using the Option Key when choosing 
almost many filters without a dialog will result in the filter being carried out on 
the whole image even if the frame is not that size. You can tell the filters which 
generally will not work this way because of the "..." to the right of the name 
(ellipsis), signifying that further user input is expected. This may vary when 
using the Quicker palette.

• To toggle the background color when in Mat mode, press the "b" key on your 
keyboard. If you have shrunk the view frame any at all, you will notice the 
background color changing to light gray,gray, to white, to the Average To Mat 
color then to black again with repeated presses of the key. When in Tool Mode, 
the B key alters the border color surrounding any extended window.

• To toggle a frame ratio from Portrait to Landscape mode, etc. , Option Click 
within the frame, or use the "t" or "T" key on your keyboard. If you are using a 
ratio other than Natural, you will swap the horizontal and vertical proportions of 
the selection frame.

• The arrow keys on the keyboard will nudge the frame 1 pixel at a time in the 
direction pressed, or a selection. To enlarge the frame, Option Key + Arrow key 
in the direction you want.  To move 10 pixels when with a Selection in Tool 
Mode, Shift + Arrow.

• To shrink the frame, Control Key + Arrow key to shrink it. When Use Ratio is 
enabled, the behavior is modified and only the left and right arrow keys will 
shrink the frame. It's a beast, I know. :)

• Don't forget to experiment! :)

• Write the author with your feature requests at <artlythere@kagi.com>

Credits

OS X Couldn’t have done it without them award: Richard Armin

Richard is a great artist and was a super motivator when the going got tough 



(and it did, often).

Thanks!

    Thanks to Andy Pritchard for being the number one beta tester in the world 
during the original development of many versions of Compositor. Offering 
ideas, suggestions and support, he is a cool dude. He lives on an island across 
the Atlantic. Some call it Britain. He is also the character within these docs 
known as Beta Guy.   Andy writes shareware too. You can download his 
creations Tracer, MacDoodle, and other top secret to-be-known goodies at <
http://website.lineone.net/~andy.pritchard> 

    Also:  A Great big Customer of The Year thanks to  Richard Armin (see 
above). Richard has a gallery available by the main Artly There Compositor 
page.  He was a early adopter of Compositor, and has been instrumental in 
keeping my spirits up during the long march to v2.5 as well as offering insights 
and testing along the way. Can't say enough.

    Thanks to Staz Software and Andy Gariepy for making such a fine 
development environment. FutureBasic^3 is a PPC native super fast language. 
Get it at <http://www.stazsoftware.com>   It's the real  Basic. Fast as C , easy 
as Pi, that's 3.14, Pi, that's FutureBasic. 

    Thanks to all those on the FutureBasic list who have helped with things over 
all the years. Smart people, cranky, inventive, and creative to boot. 

    Thanks to my dog Compositor, whom I don't have yet. But hey, what a name 
eh...Ok, update... here’s what did happen...I got a real dog...her name is 
“Lady”. No thanks to her, she’s actually been a big distraction. Fence, feeding, 
getting her back from alien abductions and such on time with memories intact, 
big pain. Don’t let it happen in your life.

    Thanks to anyone else not mentioned here yet who sincerely belongs.

    Can't forget the King of Speed, the optimizer of the world, owner and 
proprietor of Purves' Opcode and Optimization Corporation, Robert Purves.   
When you see the Gamma Adjust and Median working fast like they do, you can 
think of him kindly. That would recently also include the HSL code, which he 
enhanced (8/01). Thanks to Jay Reeves and others for code, suggestions or 
speedups with the rotation code.



    Thanks to Paul D. Bourke, Hugo Elias, and many many others whose generous 
contributions via their websites allowed little old me to learn how to do some of 
this stuff. I came up with the rest. :) Except where I didn't. 

    Thanks to NASA for any planetary images that may or may not have made it 
into this version.

And so on and so forth. 

Thanks for reading all this. Really.

Robert Covington
Artly There Software, Professional Products Division

http://www.artlythere.com

Legalese:

Photoshop™ is a registered trademark of Adobe Systems. 

If one does not know this, then one has lived in a cave as far as computer 
graphics is concerned.

Keyboard ShortCuts and Quick Tips

• To Paste a clipboard image as other than a floating selection, press the 
option key while choosing the Paste menu item. The image will be pasted as 
static, and scaled if needed.

• Press Command Key + click in the Actions Palette file list to manually rescan 
the Actions folder and list any recent additions. The rescan is automatic every 
time an actions file is saved, or the palette. is created.

• The Option Key on your keyboard is the secret to much of Compositor's 
under the hood operation, the other one being the Control Key.  In  Compositor 
Frame and Mat mode you can move the frame in various ways with these, 
enlarging or shrinking it by side. See below. The space bar will pause movie 



recording in Apply Luminosity Map scan mode (Option + Scan). The space bar 
will cancel actions in progress also.  The ESC Key will do the same

• The Option Key + Revert will Fast-revert the image, skipping the normal 
dialog and such, as long as it has not already been scaled or cropped or 
otherwise resized. IF a selection is present, only the selection will revert. Use 
Fade Last to fade the revert effect if desired.

• The Option Key + Scan in Apply Luminosity Map will bring forth the Movie 
Options dialog. Set your settings, and then recording will commence with the 
scan. Hold down the space bar to pause recording until the scan gets to what 
you wish to record again. Choose Stop or click anywhere in the dialog to end 
recording.

• The Option Key + Paste in the Edit menu when in Tool Mode will paste the 
current contents of the clipboard right over and into the current image or 
selection, at the current image size, replacing any current image without 
creating a floating selection as normal. Undo if not ok.

• The Option Key + New Using Current in the File menu when in Tool Mode will 
take the current Window view and make a new Document from  it. This allows 
you to crop an image just by sizing the window frame or pick up some view you 
have scrolled that you like in particular.

• The Option Key + Edge Fill and Edge Not Fill in the FilterVille/Edge menu will 
toggle the application of the edge color from Foreground to Background. That 
is, if the Option key is pressed, the fill color will be the Background color 
instead of the forecolor as normal. You set these colors of course using the 2 
squares near the bottom portion of the tool palette.

• The Option Key + Hued of The Lume in the Image Lab submenu (FilterVille) 
will set the saturation in the result to 100 percent. This is sometimes helpful 
when there is no hue in the image.

• The Option Key + Compass in the Edge submenu (FilterVille) will invert the 
results, for a Line Art edges look, with more robust results.

• If you have an image on the clipboard, choosing Option Key + Apply 
Luminosity Map will use the clipboard contents as the "LuMap". Otherwise, load 
an image using the Load button when the dialog comes up.



• If you have the frame in ratio, at 50% size of the image, and copy the frame, 
choosing Swap Clipboard will enlarge the frame contents to the full size of the 
image and place the original master image in entirety on the clipboard. Then a 
Paste back into the frame  will scale the entire image in proportion down by 
50%, in a nice anti-aliased fashion back into the frame. In Tool Mode, you can 
do the same, or otherwise, use the Scale dialog.

• When using Stamp Mat, the Option Key and this choice will stamp the mat 
color, and also stroke the frame color .

• The "L" key will toggle Light vs. Dark in the Shade menu choices. The B key 
will toggle the Mat color.

• Filters act on what is within the frame confines. Using the Option Key when 
choosing almost all filters without a dialog will result in the filter being carried 
out on the whole image even if the frame is not that size. You can tell the 
filters which generally will not work this way because of the "..." to the right of 
the name (ellipsis), signifying that further user input is expected.

• To toggle the background color when in Compositor View mode, use the "b" 
key. If you have shrunk the view frame any at all, you will notice the 
background color changing to gray, to white, to the Average To Mat color then 
to black again with repeated presses of the key.

• To toggle a frame ratio from Landscape to Portrait orientation, Option Click 
within the frame, or use the "t" or "T" key on your keyboard. If you are using a 
ratio other than Natural, you will swap the horizontal and vertical proportions of 
the selection frame.

• The arrow keys on the keyboard will nudge the frame 1 pixel at a time in the 
direction pressed, like wise a selection. To enlarge the frame, Option Key + 
Arrow key in the direction you want.  To move the selection or frame 10 pixels 
at a time, hold the shift key at the same time as an arrow key.

• To shrink the frame, Control Key + Arrow key to shrink it. When Use Ratio is 
enabled, the behavior is modified and only the left and right arrow keys will 
shrink the frame. It's a beast, I know. :)

• Write the author with your feature requests as well as documentation errors 



at <artlythere@kagi.com>  . Things have changed GREATLY over older versions 
as of version 2.0 and I may have missed some items, or planned to include 
them and gotten sidetracked. 


